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Chapter 1.0 Getting Started
Welcome to VisiWave Site Survey:  an advanced site survey tool that provides data collection 
and visualization capabilities not found in any other existing product.  The VisiWave Site Survey 
product provides quick and flexible data collection combined with high-powered data 
visualization and reporting capabilities to create a complete wireless LAN site surveying 
solution.

Collection of the site survey data is performed using a Windows laptop PC and a standard 
wireless adapter.  You tell the application where you are by clicking on a survey map that is 
displayed on the screen or using a GPS device to track your location.  Once data is collected, 
easily switch to the integrated reporting view to analyze the survey data and create visual reports 
of your wireless coverage.

The guide begins by going over some basic site surveying techniques.  It then describes 
collecting site survey data using VisiWave.  The guide then finishes up by discussing how to 
analyze your coverage and create reports.

1.1 Product Components
Data is collected during a site survey using a Windows laptop PC and a supported wireless 
network adapter.  This is all that is required to collect data using VisiWave Site Survey. 
Optionally, a spectrum analyzer can be used to record interference sources in the 2.4GHz or 
5GHz spectrum.

1.1.1 Wireless Network Adapter

A wireless network adapter can come in many different form-factors.  Typically, modern laptops 
come with integrated wireless support.  If not, you can normally add wireless support using either 
a USB wireless device or a PC Card.  Any of these formats are potentially compatible with 
VisiWave Site Survey.  To view a current list of supported wireless network adapters, please visit 
VisiWave's website at http://www.visiwave.com.  To determine if your wireless adapter is 
supported, you can download a free utility off of VisiWave's website called VisiWave 
CheckAdapter.  The utility quickly and easily tests your adapter to see if it supports all the 
features required by VisiWave.  The utility also rates your adapter based on how suitable it is for 
performing effective site surveys.  You need to make sure the wireless adapter is fully functional 
on your computer before testing it with VisiWave CheckAdapter.

Wireless Adapters

In general, it is best to use a client wireless device that is similar to what will actually be used in 
production.  This is because the power, antenna, features, and internal firmware can heavily 
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influence a client's wireless experience.  To best test the wireless capabilities of a space, you 
should try to use the same equipment that will be used in production.

Before using the wireless adapter, make sure you have the latest device drivers and software for 
the adapter and make sure the adapter is working properly outside of VisiWave Site Survey.

Integrated Wireless Adapters

Some computers come with wireless adapters built into the computer.  These are often the most 
convenient adapters because they are well supported, they don't need to be separately attached to 
the computer, and they make efficient use of the computer's battery.  Also, many companies 
standardize on a particular laptop with integrated wireless support so using the same integrated 
adapter for a site survey will probably provide you with the best survey results.

USB or PCI Express Wireless Adapters

External wireless adapters such as USB or PCI Express wireless adapters are also options.  If the 
client devices in a location being surveyed generally use external wireless adapters or if you need 
a feature not supported by your integrated adapter (such as an external antenna port or support for 
802.11n), then this might be the best choice for performing the site survey.

1.1.2 Wi-Spy Spectrum Analyzer

VisiWave Site Survey supports the Wi-Spy Spectrum Analyzer, a separate product from 
MetaGeek, LLC (http://www.metageek.net).  The Wi-Spy is a USB 1.1 device.  It continuously 
monitors either the 2.4GHz or 5GHz radio spectrum reporting on any radio transmissions or 
interference sources that occur in this range.  VisiWave records this information and associates it 
with a location on your survey map image.  You can then create detailed interference graphs to 
go along with your wireless coverage maps.

The Wi-Spy device is also used while collecting Wi-Fi survey data.  If you want to accurately 
graph the signal-to-noise ratio, you should plug in your Wi-Spy device while collecting Wi-Fi 
data.  VisiWave will then automatically query the Wi-Spy device to get accurate noise levels at 
each survey location.

The Wi-Spy device is completely optional.  It is only needed if you want to record RF spectrum 
data.  Even with the Wi-Spy device, normal Wi-Fi wireless characteristics are collected using a 
separate, standard Wi-Fi wireless adapter.

You can collect both spectrum data and normal wireless network data at the same time, but it is 
recommended that you only collect one of these at a time.  Having an actively transmitting 
wireless radio on your laptop may cause strongly biased interference to show up in your spectrum 
data if you collect them both at the same time.
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The Wi-Spy Spectrum Analyzer works by sampling all 1MHz frequency increments within the 
802.11a/b/g/n  frequency range.  Depending on which Wi-Spy device you have, you can record 
either just the 2.4GHz range or both the 2.4GHz and 5GHz ranges.  The 2.4GHz range starts at 
2.400GHz and goes up to 2.483GHz.  This exceeds the usable range in some countries (for 
example, the United States only uses up through 2.473GHz), but it covers the entire technical 
range of the standards.  Similarly, the 5GHz range starts at 5.160GHz and goes up to 5.835GHz 
with some frequencies not included in that range.

The spectrum analyzer briefly listens on each frequency and notes the strength of the current 
radio interference on that frequency.  VisiWave collects each of these interference levels and 
associates them with the location on the map where they occurred.  When analyzing the spectrum 
data, you can create coverage maps that show the peak and average interference levels for your 
entire survey area.

1.2 System Requirements

1.2.1 VisiWave Site Survey Data Collection Application

The data collection application requires the following minimum components:

Required

 Windows XP/Vista/7
You will need a laptop PC running Microsoft Windows XP/Vista/7 that is portable 
enough to be carried while performing a site survey.

Under Windows XP, you will need to have administrator privileges in order to have 
access to the wireless adapter.

 Supported Wireless Adapter
A supported PC Card, USB, PCI Express, Secure Digital, Compact Flash, or 
integrated wireless network adapter is required.  A free utility called VisiWave 
CheckAdapter is available for download from http://www.visiwave.com.  This utility 
tests your wireless adapter to see if it is supported.  A partial list of supported adapters 
can be found on our website.  In some cases, the latest drivers from the adapter 
manufacturer may be required.

Optional

 Wi-Spy Spectrum Analyzer
You can optionally record radio transmissions and interference sources using this 
USB 1.1 spectrum analyzer device.  No extra drivers or software are needed.
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 Google Earth Viewer
To view Google Earth files exported by VisiWave, you will need the Google Earth 
viewer application.  You can download this for free from http://earth.google.com. 
Click on the large "Download" button and follow the instructions.  After installation, 
Google Earth files are  automatically associated with the viewer so you can just 
double click on them.

You can also purchase the Google Earth Plus viewer or the Google Earth Pro viewer. 
The for-purchase versions are not required, but are supported.

 Portable Document File (PDF) viewer such as Acrobat
Viewing the user's guide requires a PDF viewer application such as Adobe's Acrobat 
Reader.  Also, site survey reports generated in the PDF format require a viewer to be 
viewed.  You can optionally generate reports in HTML format which do not require 
this viewer.  To download Adobe Acrobat Reader, visit Adobe's Web site at: 
http://www.adobe.com/
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Chapter 2.0 Performing a Site Survey

2.1 How Long Will it Take?
The amount of time it takes to survey an area is highly dependent on what type of space you are 
surveying.  An area divided into many offices or cubicles will take much longer than an area that 
is the same size, but organized as a warehouse.  And the more detailed you are in collecting the 
data, the longer the survey will take.

With this in mind, someone experienced with using VisiWave Site Survey should be able to 
complete a thorough survey of a 25,000 square foot office building in one to two hours.  This 
includes some setup time, time to connect to the network, and the time to collect the survey data. 
This does not include time spent analyzing the data and producing a site survey report.

2.2 Site Surveying Tips
 Be prepared to answer a lot of questions from employees about what you are doing. 

While performing a wireless site survey in an office building, factory, warehouse, 
campus, or hospital, you will inevitably get a lot of stares and questions.  Many times the 
people that inhabit these spaces aren’t even aware they have a wireless network.  Politely 
answer their questions, ask their permission to enter their offices to, “take a few quick 
measurements of your wireless network coverage.”

 Before you begin doing the survey, suggest that a general announcement is made to all 
employees in the survey area telling them to expect someone walking the halls and 
entering all rooms and offices taking measurements for a wireless network site survey. 
This simple email or voice mail message will ease your way through the building and 
save you time.

 Wear comfortable shoes and take several short breaks.  Doing a site survey on a 25,000 
square foot facility can cause you to walk more than two miles.  In a large facility over 
the course of a complete day, you might walk 10 miles or more.

 Be prepared to recharge your laptop computer when doing large site surveys.  Depending 
on the laptop model you are using, you may need to either recharge your computer’s 
batteries or swap in fresh batteries during the middle of the site survey.

 If you are doing a site survey at a customer’s site, many companies will want to escort 
you through the facility.  This is usually done for a couple reasons.  One is for security 
reasons.  Having an escort along allows you to gain access to areas you might not 
normally be able to enter and prevents you from having to justify your presence to 
security personnel or other employees.  The other main reason is to be there to assist you 
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with any questions you have about the facility including access to some locations and 
what areas the customer actually wants surveyed.

 Many facilities have special rules that apply either to the entire facility or to certain areas 
of the facility.  Go over any of these rules with the facility manager before starting the site 
survey.  And be aware of the areas with special requirements and obey these rules while 
performing the site survey.  Some facilities require special attire such as hard hats, lab 
coats, or safety glasses.  Also, some locations do not allow electronic equipment that may 
cause sparks, some areas do not allow cell phones or computers for security reasons, and 
some areas require special permission to enter.  

 If you are doing a site survey of an entire building, you may want to walk around the 
outside perimeter of the building to get a measurement of the signal loss that occurs due 
to the buildings outer-shell.

 If the area you are surveying is very large, you may want to consider splitting the area into 
several smaller sections.  To do this, create one survey data file for each section.  Once all 
the survey data is collected and before you start analyzing the results, you can combine 
the several sections back into a single survey data file using the Merge Survey Files 
feature (see section 3.7 Merge Survey Files).

 When doing a site survey of a multi-floor building, you need to do each floor as its own 
separate site survey.  You just treat each floor as if it were a building on its own. 
However, to simplify the process of setting up each survey file, you may want to create 
one survey file and fill in all its properties and then make several copies of this survey 
file, one for each floor.
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Chapter 3.0 Data Collection
Be sure to read Chapters 1 and 2 before performing a site survey.  In particular, see Chapter 1 for 
instructions on how to set up the site survey tool.

3.1 Connecting to the Wireless Network
You can optionally associate with a wireless network prior to performing the site survey, but this 
is not required.  If you are associated with the network, then VisiWave will make note of this in 
the survey results.  Also, you can obtain additional metrics from an associated access point than 
you can from unassociated APs.  For example, you can record the number of transmit/receive 
collisions or the round trip times from associated APs, but not from unassociated.

Regardless of whether you are associated or not, you will be able to report on access points that 
you are near, but not necessarily connected to.  VisiWave Site Survey allows you to do network 
stumbling.  You will be able to detect not only the access points in your network, but also access 
points from neighboring businesses, homes, or hotspots.  You'll also be able to discover rogue 
access points.  These access points can then be plotted and examined in your reports.

3.2 Starting VisiWave Site Survey
You start VisiWave Site Survey just like any other application.  Click on the Start button, then 
select All Programs.  Click on the VisiWave Site Survey menu item.  Under that menu, click on 
VisiWave Site Survey.  If you had the installer create a desktop shortcut, you can also just click 
on that icon to start VisiWave Site Survey.  Figure 1 shows the screen that you will first see.

3.2.1 Windows XP's Wireless Zero Configuration

This section only applies if you are collecting survey data while running Windows XP.  Windows 
XP has a service called Wireless Zero Configuration, or WZC for short.  WZC automatically 
configures your wireless network adapters and connects you to wireless networks.  This is done 
for any wireless adapter that has drivers that support WZC.  In order for VisiWave Site Survey to 
have the access to your wireless network adapter that it needs, the WZC service has to be 
temporarily stopped.  VisiWave Site Survey does this for you behind the scenes.  Just before 
collecting wireless data, the product stops the WZC service if it detects that it is running.  The 
product automatically re-starts the WZC service when it is done.  This means that if you insert a 
new wireless adapter into your laptop while VisiWave Site Survey is collecting data, the new 
wireless adapter might not get configured.  You should always exit VisiWave Site Survey before 
inserting or removing a wireless adapter that is managed by WZC.

If for some reason VisiWave Site Survey isn't able to re-start the WZC service, you can do it 
manually.  From the Windows XP Start menu, click on Control Panel.  Then select 
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Administrative Tools.  Then double-click on the Services icon.  Locate the Wireless Zero 
Configuration service in the list.  If its status is currently set to stopped, right click on the entry 
and then select Start from the pop-up menu.

3.3 Creating a New Site Survey File
This section goes through creating a new site survey file and the major steps involved in properly 
collecting survey data.  The end result will be a survey data file that you can use to analyze your 
wireless coverage.

3.3.1 New Site Survey File

After launching the program on your laptop, the main screen (shown in Figure 1) is displayed and 
a window appears asking you to supply a survey map image file.  If you are creating a new survey 
file, then you should supply the survey map image file.  To find out more about how to do this, 
see section 3.3.2 Setting Properties, below.  If you want to open an existing survey file, press 
“Cancel.”

Figure 1 - Survey Map Properties dialog

The new survey file is loaded and displayed in the main application window, shown in Figure 2. 
If you already specified a survey map image file, then the survey map is displayed on screen. 
Once you start collecting data, the survey data is displayed over top of the survey map image.  At 
the bottom of the screen is a status bar.  Messages indicating what was just done or what needs to 

VisiWave Site Survey User's Guide 8



be done are displayed in the left portion of the status bar.  On the right side of the status bar are 
various indicators.  More details about these indicators will be discussed later.

Figure 2 - Main Application Screen

At the top of the screen is a tool bar.  The tool bar contains buttons that are just shortcuts to menu 
items found under the various menus.  To see what function each menu button performs, hold 
your mouse over the button without clicking it.  A description of the button will appear on the 
screen.

On the right side of the screen is the Access Point List.  This lists all the access points found in 
the current survey.  You can select one or more of these access points to have a coverage graph 
overlaid on the survey map.

3.3.2 Setting Properties

The first thing that should be done with every new survey is to set some of the survey properties. 
You do this by selecting the Survey Properties menu item found under the Survey menu.
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After selecting Survey Properties or when first creating a new survey file, the dialog in Figure 1 
appears.  This dialog has tabs that let you switch between several different properties pages. 
Except for the Survey Map Image, the other properties are optional, but a few can be very helpful 
if they are set.

The Map properties page is where you associate a survey map image with this survey.  The 
survey map image might be a two-dimensional rendering of the walls, rooms, and hallways of the 
building being surveyed or a satellite photograph of the survey area.  The survey map is displayed 
on the main application screen to assist in keeping track of where you are while collecting survey 
data.  Section 3.5 Creating a Survey Map Image describes how to create and use survey map 
images.  For now, just click the Browse button and select the sample floor plan image supplied 
with the product.  It is called “SampleFloorplan.gif”.

Next, go to the Name properties page.  The Name field on the Name page should be set when the 
survey is first created.  The survey file’s name will be derived from this value.  You can save the 
file to a different name using the Save As menu item.

For now, type in something like “My Survey” in the Name field.  You can also fill in some of the 
other fields found on the Name and Location tabs.  These fields will help you identify exactly 
whom the survey is for and where the survey took place.

Now that the properties have been set, you can press the "OK" button to save the properties. 
Next, the Set Survey Map Scale window appears. For now, just click on Set Manually and then 
click in the Scale entry field and enter either 0.2123 ft or 0.0647 m, depending on whether you 
are using feet or meters as your unit of measure.  This indicates either the feet to pixel ratio or the 
meter to pixel ratio between the real world and the image.  Knowing this scale allows the 
application to correctly plot your real world movements on top of the floor plan image.  If you 
are going to use a GPS device, you must accurately set the scale value.  But if you aren't, then the 
scale is not absolutely essential.  It only effects the validity of the dimensions shown while 
collecting data and in the reports.  You should now see the survey map image drawn on the 
screen.

Also note that if you are collecting data using GPS or plan to create reports using the Google 
Earth support, then your survey map should be oriented such that north is pointing to the top of 
the image.  Once you start a survey, there is no way to rotate an image to fix this and without the 
top of the image pointing north, data collected using GPS will be rotated and the coverage graphs 
in Google Earth will also be rotated.

3.3.3 Collecting Wi-Fi Data Versus Spectrum Data

In normal operation, you want to make sure you are collecting Wi-Fi data.  This is done by 
making sure a checkmark is next to the Collect Wi-Fi menu item under the Survey menu.  This 
means that while you are collecting survey data, your wireless adapter is collecting radio 
characteristics such as signal strength and communication channels.
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If, however, you have the Wi-Spy Spectrum Analyzer and you wish to collect spectrum data, you 
should make sure Collect Wi-Fi is not checked and that the Collect Spectrum menu item is 
checked.  Also, you should make sure your wireless adapter is disabled on your computer while 
collecting spectrum data.  While you can collect Wi-Fi data and spectrum data at the same time, 
the wireless adapter will show up as strong interference in the spectrum data.  It is best to collect 
spectrum data and Wi-Fi data in two different passes.  You can collect both types in the same 
survey file, it's just not advisable to collect them simultaneously.

Important:  You can collect background interference while collecting Wi-Fi data if you have a 
Wi-Spy device.  To do this, just be sure your Wi-Spy device is plugged in before collecting any 
survey data.  VisiWave will automatically query the interference values and store them off for all 
access points discovered during a survey.

3.3.4 Placing Access Point Markers

This next step is an optional, but useful step.  To better identify the area being surveyed, you can 
indicate the location of access points on the survey map.  An access point is typically a device 
that contains a wired network connection and a radio and functions as a bridge between the wired 
and wireless worlds.

Access points that are in radio range of VisiWave Site Survey are automatically discovered.  But, 
their exact location can’t be automatically determined.  You can explicitly place an access point 
by simply pressing the Add AP Marker button and then clicking on the location on the survey 
map image that corresponds with where the access point actually is.  Note that this marker is for 
your use only.  VisiWave does not use the AP marker to perform any of its calculations.  This is 
an icon for your use in identifying the existing APs in the survey area.

The access point appears on the display at the location you indicated.  It is automatically given 
the name “Unnamed AP Marker”.  To change the name or link it with one of the discovered 
access points, you need to access its popup menu.  You access the popup menu by right-clicking 
on the access point marker.  You can then choose between changing its properties and deleting 
the access point.  If you chose to delete the access point, it will be permanently removed from the 
survey once you confirm your action.

Figure 3 - AP Marker Properties dialog
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If you select the Properties menu, a dialog like the one shown in Figure 3 will appear.  In this 
dialog, you can set access point attributes.  In the Name field you can assign a name to the access 
point that is meaningful to you.  You can pick the Media Access Code (MAC) address for this 
access point from the choices supplied in the drop-down list.  This list is populated with the 
MAC addresses that have been discovered by the application while collecting survey data.  Since 
you probably haven’t started collecting data yet, this list will be empty.  But, after you have 
collected some survey data, you can come back to this dialog and see if the access point’s MAC 
has been discovered.  When you do select a MAC address, the Service Set Identifier (SSID) 
discovered for that MAC address is displayed.  The SSID field cannot be modified.

You don’t have to associate an access point with a discovered MAC address.  You may just want 
to mark the location of a potential or former access point.  In this case, you can set the Name 
field to something that describes the purpose of this access point.

3.3.5 Collecting Survey Data

You are now ready to start collecting survey data.  It is here that the actual site survey takes 
place.  You walk the floor of the site collecting signal characteristics.  The computer's display 
gives a graphical representation of where you are and what has been surveyed.  After the data is 
collected, the survey data can be analyzed using the reporting view or another survey can be 
performed.

Before jumping into collecting data, give some thought to where you plan to survey and how you 
plan on covering that area.  Also keep a look out for possible obstacles or difficult areas for you 
to reach on foot.  You may need to momentarily stop data collection to deal with these problem 
areas.  This won’t be an issue since normally a survey file consists of several segments of 
collected data.  You can easily collect data in one area of the building, stop the data collection, 
and then re-start collecting data in a different area.

There are actually many different ways to collect survey data.  Each is distinguished by how your 
position is tracked.  These different modes of collecting data are referred to as Capture Modes. 
Each mode has its own advantages and characteristics.  VisiWave supports Point-by-Point 
capture mode, Continuous capture mode, and using a GPS device.  Any of these modes can be 
used within a single survey file.  And the modes can be freely intermixed.  You should use the 
capture mode that works best for the area you are currently surveying.

Point-by-Point Capture Mode

To collect a single point, make sure the Point by Point Capture Mode button ( ) is depressed. 
Then click the location on the survey map image that represents where you are in the real world. 
A few data points will be collected at that location and stored as part of the survey data.  Also, a 
small marker will appear on the screen that indicates where you collected that data.  You can 
continue to click the screen as you walk the survey area.  Each click adds another point to the 
survey data.
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Continuous Capture Mode

To collect many data points at a time, make sure the Continuous Capture Mode button ( ) is 
depressed.  Then press the Start Collecting button ( ).  When you are ready to start collecting 
data click the location on the survey map that represents where you are in the real world and start 
walking at a steady pace and in a straight line.  While you walk, a continuous stream of data is 
collected.  When you are done with a straight segment click the screen again to tell the 
application where the end of your straight path is.  The application then spreads the collected data 
evenly over the line between the first click and the second click.  After the second click, you can 
continue walking in a new direction and add another segment by continuing to click the screen on 
every turn or you can press Stop.  Note that when you press Stop, all data collected since the last 
screen click is not saved.

Figure 4 - Continuous Capture Mode

The process of continuously adding data points is represented in Figure 4, above.  After pressing 
Start Collecting, the user clicked the screen at location A and then walked directly to location B. 
The user then clicked the screen at location B, turned in the direction of location C, and then 
walked to location C.  Once at location C, the user clicked the screen again.  Then the user 
walked to location D and pressed Stop.  The data points collected while the user walked from 
location A to location B were spread out evenly between location A and B.  If 5 data points were 
collected, then the first one was assigned to location A, the second data point was assigned to one 
quarter of the way to location B.  The third and fourth data points were assigned to one half and 
three quarters of the way to location B, respectively.  And the fifth data point was placed at 
location B.  No data was assigned between location C and location D because the user only 
pressed Stop at location D—rather than clicking that location.

Note that you can also double-click on your location on the survey map to both start collecting 
data continuously and mark your initial location.  Just make sure that the Continuous Capture 
Mode is currently selected.
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GPS Position Tracking Mode

To collect data using a GPS device, make sure the GPS Capture Mode button ( ) is pressed. 
The first time you collect data in any survey file, you will need to click on your current location 
to tell the program where the longitude and latitude reported by the GPS is in the real world. 
You only need to do this once for each new survey file.

Press the Start Collecting button ( ).  The first time, you are prompted to click on your current 
location.  Make sure your GPS device is properly connected to your computer and is receiving a 
good signal from enough satellites to get a good fix on your location.  Then click on OK to 
dismiss the prompt.  Then click on your location on the survey map image.

If you get an error saying that the program couldn't communicate with the GPS device, you need 
to check several things.  Make sure the device is connected to the computer and that
it has a good fix on your location.  If you are using a serial GPS device,
make sure it is configured to send NMEA position information over the serial link, and you have 
the correct GPS Port and Baud Rate set (look under the Options menu item).  If you are using a 
USB device, make sure your model is supported (currently only Garmin or Garmin compatible 
USB devices will work) and make sure you set the GPS Port option to USB.

If no error occurs, a position marker will appear where you clicked.  The program is now 
collecting wireless data.  As you move around in the survey area, the GPS device will keep 
feeding position information to the program and the position marker will move indicating your 
current location.  A survey trail will appear showing where you have been.  You can stop 
collecting data at any time by pressing the Stop button ( ).

You can collect more data using your GPS device at any time by just pressing the Start 
Collecting button again.  This time, you will start collecting immediately without any other 
interaction.  You can verify this by watching the status bar where the count of data points 
collected will increase.

Survey Trail

As you collect survey data, a line is drawn on the screen that represents where you have been. 
This is called the survey trail.  The survey trail maps out where you have been and also shows 
areas that still need to be surveyed.  Additionally, the survey trail can indicate the strength of 
signal recorded while collecting data.  Depending on your current configuration settings, the 
survey trail can be color-coded based on the Signal-to-Noise Ratio (SNR).  Darker colors 
indicate a strong signal.  Brighter colors indicate weaker signals.  The strongest to weakest colors 
are: blacks, blues, greens, oranges, yellows, and reds.

Collect Spectrum Data vs. Wi-Fi Data

When collecting spectrum data using the Wi-Spy Spectrum Analyzer, the survey trail is drawn as 
a dashed line rather than a solid line.  Also, point-by-point spectrum data points are small hollow 
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squares rather than the rounded points that are drawn for Wi-Fi data.  The color of the dashes or 
squares again represents the signal strength of the collected data point.  Just as before, the darker 
colors represent higher signal strengths and the brighter colors such as reds and yellows indicate 
lower signal strengths.  The main difference is that with spectrum data, you want the brighter 
colors to show up (which indicate little or no interference was found).

3.3.6 Access Point List

While collecting data, you can view the current list of Access Points in a pane along the right 
side of the application window. If you can't see this pane, you should be able to grab the left edge 
of the right window border and drag the pane open. The AP list contains all the access points 
discovered in the current survey. They are grouped by SSID. You can expand or collapse the APs 
under any of the SSIDs.

Viewing Coverage Graphs

At any point, you can view the current signal strength coverage graph by putting a checkmark 
next to one or more APs in the AP list. If you select just one AP, then only that access point is 
included in the coverage graph. If you select more than one, then a coverage graph that combines 
all selected APs is displayed.

If you have collected spectrum (interference) data for this survey, then you will see an entry at the 
bottom of the list for "Spectrum Data". You should see one for 2.4GHz spectrum data and 
possibly one for 5GHz spectrum data, depending on what was collected. You can put a 
checkmark next to one or more of the channels listed under these entries to view an interference 
graph for the selected frequencies. Note that selecting one of the spectrum data entries will 
unselect any access point entries since you can't combine both access points and spectrum data 
into the same coverage graph.

Marking Estimated AP Locations

To have VisiWave estimate the location of one or more selected access points, put a checkmark 
next to Mark Estimated AP Locations. When this is checked, a small target icon will appear on 
the graph for any access point that is currently selected. The target will appear in the location that 
is VisiWave's best guess as to where the real access point is located. This guess is only as good 
as the data that is collected so the more data that is collected, the better the estimate will be.

Selecting Entries

You have the ability to select or unselect entries using the control below Mark Estimated AP 
Locations. Pick the Select All (APs) option if you want to put a checkmark next to every access 
point listed in the AP list. Pick Select None to unselect all access points and spectrum data 
channels. Pick Select Only One if you want the ability to just click on the single item you wish to 
include in the coverage graph. This will automatically uncheck any other entry that is already 
selected.

VisiWave Site Survey User's Guide 15



Color Thresholds

You are able to set the signal strengths that are used as the boundaries between the three different 
colors of the coverage graph. You enter two different boundary values. The first value indicates 
the signal strength (in dBm) at the point where the gold/brown colors switch to green colors. The 
second value indicates the signal strength where the green colors switch to blue colors. For 
example, if you select -80 and -60, then all areas with a signal strength less than -80dBm would 
be colored a shade of gold/brown. All areas with a signal strength between -80dBm and -60dBm 
would be a shade of green. And all areas with a signal strength greater than -60dBm would be a 
shade of blue.

Transparency

A slider is included that lets you select the transparency of the coverage graph. Moving the slider 
to the left causes the overlaid coverage graph to become more transparent. Moving it to the right 
causes the graph to become more opaque.

3.3.7 Viewing Data Point Information

While you are collecting data, some times you want to see how things are going.  You can do this 
by hovering your mouse pointer over any collected data point or clicking on the data point. 
(Make sure the Pan Display button is pressed—you can’t do this while any of the capture modes 
are selected.)

You are able to see a list of access points that were discovered at that data point and details about 
each of those access points.  You can also view interference data if you collected spectrum data 
at that point.

You can view detailed information about every data point collected by just hovering your mouse 
pointer over the data point and then clicking on the data point.  Hovering will let you view the 
signal strength for that point.  If more than one point is under the pointer, a list of data point 
numbers is also shown.

Clicking on a data point brings up a balloon containing details of the data point.  If more than one 
data point was under the pointer, then a list of data point numbers is included at the bottom of the 
balloon.  Clicking on any of these (they appear as blue, underlined text) shows you details on that 
data point.  If more access points are available than will fit in one balloon, then a link labeled 
[More] will appear that lets you view another page of access points.

If you collected spectrum data, you can also view details on the interference found at each data 
point.  Clicking on a data point will bring up a balloon.  This balloon will contain the 
interference found on each Wi-Fi channel.  Near the bottom of the balloon is a link labeled 
“Frequencies”.  Clicking on this will display the frequencies that had a noise level greater than 
the average noise level for that location.  Again, if more are available than will fit on one screen, 
then you can view more pages by clicking on the [More] link.
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To remove the balloon, just click anywhere on the display.

3.3.8 Status Bar

The status bar is located near the bottom of the display.  The status bar is divided into several 
panes.  Many of the panes are left blank unless you are currently collecting data.

Figure 5 - Status Bar

The left-most pane is an area for status messages.  These messages indicate what was just done 
or what needs to be done.

The pane to the right of the status message area contains GPS status information.  When not 
collecting data using the GPS, this pane shows the latitude and longitude of the location under 
the mouse pointer.  When actively collecting data, this pane shows the accuracy of the GPS data 
being received.

The next pane to the right contains the current zoom percentage.  A value of 100% means the 
survey map image is displayed at its full size.  A value less than 100% means that the survey map 
image is reduced in size so you can see more of the survey map.  A value greater than 100% 
means the survey map image is zoomed in to show more details.

The pane labeled “Points” is a count of the total number of data points collected so far.  This 
number usually goes up by one whenever a single data point is added.  When many data points 
are continuously collected, the count can increase by as many as several a second.

The next pane (second from the right) contains the Signal Level and Signal-to-Noise ratio. 
While collecting data, this shows the signal strength for the last data point collected. The Signal 
Level is listed in dBm. The Signal-to-Noise ratio indicates the relative strength, in dB (decibels), 
of the wireless radio transmission when background noise is taken into consideration. When you 
are not collecting data and a coverage graph is overlaid on the survey map, the signal strength of 
the point under the cursor is displayed in this pane.

Listed in the far right pane of the status bar are your current coordinates.  If you are collecting 
data using a GPS device, this panes shows the coordinates of the last collected data point. 
Otherwise, this panes shows the coordinates of where the mouse pointer is pointing.  The first 
number is the number of feet (or meters) you are from the origin.  If it is positive, you are 
currently right of the origin and if it is negative you are left of the origin.  The second number is 
the number of feet (or meters) you are above the origin if it is positive or below the origin if it is 
negative.  The origin is usually at the center of the survey map image, unless the survey map 
location was adjusted using the Relocate Survey Map menu item.
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3.3.9 Zooming Display

If you are surveying a large area, the entire area may not comfortably fit on your computer's 
display.  Or, you may want to focus on a single area of the entire building.  You can use the 
Zoom menu item under the View menu to zoom the display in and out.

The Zoom In menu item shows you greater detail but doesn't let you show as much overall area. 
The Zoom Out menu item shows you less detail but you can see more area on your screen.  You 
can repeatedly select one of these menu items to increase or decrease your zoom level.  You can 
zoom out until you are viewing the data at only 10% of its actual size and you can zoom in until 
you are viewing the data at 5000% of its actual size.

By default, the zoom level is 100%.  That means that the survey map image is shown at actual 
size.  You can select the Actual Size menu item to return to a zoom level of 100%.

You can also select a zoom level of Auto.  What this means is that the application automatically 
sets the zoom level to a value that keeps the entire survey area in the display.  This works if you 
are surveying a fairly small area, but if the survey area becomes large, you may want to pick a 
zoom level that lets you see more detail.

You can also use the scroll wheel on your mouse to zoom in and out.  By pressing the Shift key 
on your keyboard and spinning your mouse's scroll wheel, you can zoom in and out.  Scrolling 
away from you zooms in and scrolling towards you zooms out.

3.3.10 Panning Display

Depending on the size of the survey area and the current zoom setting, you might not always be 
able to see the entire survey area on the computer's screen at one time.  Some of the area may be 
out-of-view or “off the screen”.  To bring these other areas into view, you can pan the display.

You pan the display by clicking with the left mouse button and dragging the mouse.  If you spin 
your mouse's scroll wheel, you can scroll up or down.  And you can also use the horizontal or 
vertical scroll bars to pan the screen.

When you first start a survey, you are in “panning mode.”  In order to add data points to the 
survey, you need to leave panning mode and enter one of the modes that let you add data points. 
To return to panning mode, select the panning button ( ) on the menu bar.  Whenever this 
button is depressed, clicking on the screen and moving your mouse causes the screen to pan.

3.3.11 Deleting Data

Any survey data or access points added to a survey file can be removed.  Access points can be 
deleted by accessing their popup menus.  You do this by right-clicking on the access point to 
access the popup menu.  Once you see the popup menu, select the Delete menu item.  A 
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confirmation dialog appears.  If you chose to delete the access point, it will be permanently 
removed from the survey.

Another way of removing elements is to use the Clear menu item under the Survey menu. 
Options exist to delete all the access points, all the survey data, the last segment of survey data 
collected, or all of the above.  Since each of these operations is permanent, you are prompted for 
confirmation before the action is carried out.

If you begin to collect survey data and something doesn’t go right—you click on the screen in the 
wrong place or you were interrupted while adding several data points along a path—you can use 
the Clear->Last Data Segment menu item to remove all the data points in the segment just 
added.  A segment consists of all the points collected between pressing Start and pressing Stop 
or any single data point added.  Once you have deleted the last segment, you can continue to 
select this option deleting each previous section until there are no more segments.

The Clear->All operation might be done for two common reasons.  One is that for some reason 
you got off to the wrong start and just want to start over.  The other reason is because you are re-
using a survey file.  For example, you may create a survey for the first floor of a building.  After 
performing the full survey for that floor, you move to the second floor.  Instead of re-entering all 
the properties again for the second floor, you make a copy of the first floor survey file and use 
that as a basis for the second floor survey.  You can select Clear->All to remove all the survey 
data related information, but keep the survey properties intact.

You can delete individual data points by clicking the data point while in Pan Mode.  This brings 
up a balloon that shows all the information about that data point.  In the balloon is the word 
“Delete” that is in blue text and underlined.  Click on that label and then press Yes to confirm. 
This deletes that particular data point and automatically shows the next data point.  You can 
simply press the Delete button as well.  Pressing the Delete button followed by the “Y” key 
repeatedly while delete many data points in a row.

3.3.12 Saving Survey Data

You save your survey data by selecting the Save menu item under the File menu.  This saves all 
collected data to the current survey file.  If you haven't saved the data before, you are prompted 
for a new file name to write to.

If you don’t want the current data to overwrite the data that was in the survey file when you first 
loaded it, you should select Save As... from the File menu to save the survey file to a new name.
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3.3.13 Exporting Spectrum Data to CSV File

If you have collected spectrum data using the Wi-Spy Spectrum Analyzer, you can export just the 
spectrum data to a CSV file (Comma Separated Values file) using the Save As... menu item.  To 
do this, just set the Save as type in the Save As dialog to “Wi-Spy CSV File,” then either give 
the filename an extension of “.csv” or no extension, and then press Save.

The resulting file can be loaded in either a spreadsheet program such as Microsoft Excel or 
directly into older versions of the Wi-Spy program that comes with the Wi-Spy Spectrum 
Analyzer.  The Wi-Spy program provides different views of the spectrum data—mainly views 
that are time-based but not location-based.

3.3.14 Relocating the Survey Map Image

The Relocate Survey Map menu item in the Survey menu is used to adjust the position of the 
survey map in relation to the collected survey data.  This is usually only done when you add or 
change a survey map image to a survey file that already has collected survey data or if you collect 
data using a GPS device and the initial location you set isn't accurate.  This feature lets you move 
the survey data across the survey map until the two line up.

After selecting this menu item, you can click and move the display to pan the survey data.  As 
you move the mouse around the screen, the survey data moves, but the survey map stays 
stationary.  Once you have the survey data in the correct place, press the Stop button on the tool 
bar to complete the operation.

3.4 Setting Options
Various configuration values are set from the Options menu item.  The Options menu is found 
under the File menu.  Selecting this menu item brings up a dialog where you can view and 
change the current configuration values.  Changing a value takes effect once you press the “OK” 
button.

3.4.1 Assistance Level

The assistance level indicates how much interactive help you will receive while performing a site 
survey.  If this is set to “Full,” a series of messages will be displayed as you perform different 
steps in the site survey process.  The first few times you use the product, these reminders will 
probably be useful.

Once the basic operations of the program are mastered, you will probably want to set this option 
to “None”.  With this setting, the extra messages are not displayed. 
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3.4.2 Units

VisiWave Site Survey supports units of “feet” and “meters”.  You can freely switch between 
these units.  For example, if you create a survey with this set to “feet” and then later change this 
to “meters”, the existing survey will display accurately using meters as a unit and new data can 
still be added to the survey file. 

3.4.3 Survey Trail

The survey trail is the path that you walk while collecting survey data.  It is the line drawn on the 
display as you collect data.  This line can be color-coded to represent the Signal-To-Noise ratio 
(radio strength) found at each point or it can be just a solid line.  Normally you will probably 
want to leave this as a color-code line.  But, if you have a very large survey file, setting this to 
“Solid” will give you slightly better performance.  Also, if you find the color-coded lines more 
difficult to see, you may want to set this to “Solid.”

3.4.4 Wireless Card

Listed under this option are all of the supported wireless network adapters that VisiWave Site
Survey could find currently installed in the computer.  If you don't see a wireless adapter you 
expected to see, make sure that your wireless adapter is functioning properly outside of 
VisiWave Site Survey.  This setting is really only useful if your computer has more than one 
supported wireless adapter.  This allows you to explicitly select the wireless adapter that is used 
for the site survey.  If this value is unset (blank), one of the adapters is automatically selected.

3.4.5 Sound Effects

Setting this value to “New Data Point” causes VisiWave to play a “ding” sound every time a new 
data point is collected.  The volume of this sound can be adjusted by simply adjusting your 
laptop's speaker volume.  If you don't wish to hear this sound, you can set this to “None”.

3.4.6 Calculate RTT

Normally the round trip times for pinging the default gateway are recorded each time a data 
sample is taken by the product.  This option lets you disable this by selecting “No”.  The main 
reason to disable this is to prevent the data collection device from constantly using the wireless 
network.  The sending and receiving of data by the collection device may affect the wireless 
characteristics of the network.
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3.4.7 GPS Baud Rate

The GPS Baud Rate option tells VisiWave Site Survey how fast the GPS device is configured to 
communicate with your computer.  The NMEA standard requires 4800 baud (or bps) but some 
GPS devices can be configured to communicate at faster rates.

3.4.8 GPS Port

The GPS Port option tells VisiWave Site Survey which communications port the GPS device is 
attached to.  If you have a supported USB GPS device, then you should set the GPS Port to USB. 
If you have a serially attached GPS (or a USB device that creates a virtual serial device), then you 
should select the COM port that your device is attached to.

3.5 Creating a Survey Map Image
A survey map image is a picture of an outdoor area or a two-dimensional drawing of a building’s 
walls, rooms, and hallways as viewed from above.  The image is drawn to the same proportions 
as the physical area, but at a much reduced scale.  It can contain many details or it can be sparsely 
detailed.

A survey map image is used during a survey for two reasons.  One reason is it allows you to tell 
the application where you are in the survey area by clicking on the location on the survey map 
image that represents where you are in the real world.  The other reason is that the survey map 
image can be superimposed over the graphical report data.  This lets you easily see where the 
strong and weak signal strengths are in the survey area.  See the Transparency property for more 
information about superimposing the survey map image over the graphical data.

3.5.1 Image File

If you are using a floor plan drawing as your survey map, then typically a building’s owner or 
architect has the building’s floor plan rendered in a computer readable format.  The floor plan 
may be in a computer aided drawing (CAD) file or in a bitmap file format like Windows BMP, 
GIF, or JPEG.  If the floor plan only exists as a CAD file, it will need to be converted to a bitmap 
file before VisiWave Site Survey can use it.  The CAD software can usually export the floor plan 
as a bitmap file type such as JPEG.

If you are using a picture such as a satellite view as your survey map, you may need to do a 
screen capture to get the image in a usable format. To do this, display the image on your 
computer's screen then press Ctrl-PrintScreen on your keyboard. This puts the current screen in 
the clipboard as an image. Now you can run Windows Paint (found under the Accessories 
program group under All Programs in the Start menu). In Paint, select Edit->Paste to paste in 
your screen's contents. Next use the Select tool to highlight the area of the screen that contains 
your survey map. Then select Edit->Copy and then Edit-Paste to create a new image that only 
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contains your survey map. Now select File->Save to save the image as a new file. Before saving, 
be sure to select a file type such as PNG, JPEG, or GIF.

If the survey map is only available on paper, you should be able to scan the paper version using a 
scanner connected to a computer.  The scanned in version can then be easily converted to an 
appropriate format for use by VisiWave Site Survey.

The bitmap formats supported by VisiWave Site Survey include Windows BMP, GIF, JPEG, and 
PNG.  Note that Windows BMP files that use Run Length Encoded (RLE) compression are not 
supported.

The size of the image should be somewhere between 200 pixels on a side and 2000 pixels on a 
side.  If you use images much larger than 2000 pixels on a side, you won't be able to zoom in 
very much and you might run into memory limits.

If you are collecting data using GPS or plan to create reports using the Google Earth support, 
then your survey map should be oriented such that north is pointing to the top of the image. 
Once you start a survey, there is no way to rotate an image to fix this and without the top of the 
image pointing north, data collected using GPS will be rotated and the coverage graphs in 
Google Earth will also be rotated.

3.6 Setting the Survey Map Scale
The first time you associate a survey map with a survey, you will need to supply the scale of the 
image. The scale is measured in either feet per pixel or meters per pixel. Supplying this allows 
the data collection tool to know how to map real world dimensions to dimensions that work in 
the simulated world on the computer's display. If you have an image that is 1000 pixels by 800 
pixels that represents an area 500 feet by 400 feet, then the scale is 0.5ft/pixel. This is because 
the area being surveyed is 500 ft wide and the image is 1000 pixels wide (or 500ft/1000pixels = 
0.5ft/pixel). Note that the scale needs to be the same for both the width and the height.

If you aren't using a GPS device to collect data and you don't need to create Google Earth reports, 
you can just guess at this value if you don't mind the dimensions being a little off in the data 
collection application and the reports. For example, if you enter “1.0” (1 ft/pixel) in the scale 
field and the true scale is really “2.0”, then on screen it may say that you placed a data point at 
position (10, 6)—ten feet to the right of the origin and six feet above the origin—when you really 
placed it at (20, 12). And the report might show that the survey area is 200 ft by 100 ft, but in the 
real world, the area surveyed is 400 ft by 200 ft.

If you are planning to use a GPS device to collect data, the scale parameter must be set as 
accurately as possible. You also need to set the scale if you want Google Earth reports to appear 
in the correct location on the earth's surface.
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When determining the scale, you don't have to use the entire width or height of the survey area. 
You can also use any horizontal or vertical distance in the survey map to determine the scale. For 
example, if you know the length of a wall in the real world and you find out the number of pixels 
that the wall covers in the survey map image, you can divide the length in feet by the length in 
pixels to get the scale. Just make sure that the distance is relatively long so your measurements 
are accurate.

3.6.1 Setting the Scale

When you first create a new survey file you are asked to set some survey properties such as the 
Survey Map Image File. Once these are set, you are next asked to set the scale. You can do this 
one of two ways: manually or interactively.

Or, if you already created the survey file and just want to change the scale, you can do this by 
selecting Set Scale under the Survey menu.

3.6.2 Setting the Scale Interactively

When viewing the Set Survey Map Scale window, select the Set Interactively option at the top of 
the window. Behind this window you can see the main window and the survey map image. In 
this mode, you can click on the survey map image to place the start and end of a segment on the 
map you wish to use to specify the scale. To do this, just click on the survey map image. A green 
square appears. Click on the image in a second location. Another green square appears and a line 
is drawn between them. Now go back to the Set Survey Map Scale window and click in the 
Length in Feet (or Length in Meters) entry field. Enter the length in feet or meters of the line you 
drew on the survey map. Doing this automatically sets the scale.

3.6.3 Setting the Scale Manually

You can also manually set the scale by selecting the Set Manually option at the top of the Set 
Survey Map Scale window. In this mode, you can't click on the survey map image to figure out 
the length of a segment in pixels. Instead, you have to either know the length in pixels or you 
have to know the scale.

When setting manually, you can either directly enter the scale or have VisiWave calculate it for 
you. To directly enter the scale, click in the Scale entry field and type in the scale (for example, 
enter “0.2” or “1.333”). Or, if you know the real-world length of some object in the survey map 
(such as a the length of a hallway) and you know how many pixels that object takes up in the 
survey map, you can enter both the lengths necessary to calculate the scale. Do this by clicking in 
the Length in Feet (or Length in Meters) field and entering the real-world length. Then click in 
the Length in Pixels field and enter the length of that object in pixels. VisiWave will then 
calculate the scale for you.
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3.7 Merge Survey Files
When collecting measurement data during a site survey, you may find it convenient to split the 
survey area up into sections and creating a different survey data file for each section.  For 
example, the survey data collected in an office area may be saved in one survey data file and the 
survey data from the attached factory may be saved in a second survey data file.  When it comes 
time to analyze this data, you may want to combine all the separate sections into one large survey 
data file.  You can do this using the Merge Survey Files... menu item.  This operation combines 
several survey data files into a single, new survey data file.

Figure 6 - Merge Survey Files Dialog

In order to merge survey files, you need to provide the main survey file, the list of additional 
survey files to merge, and the name of the new survey file that will contain the results of merging 
all the survey data files.  The main survey file is an existing survey data file.  The survey 
properties from this file will be passed on to the new survey file.  The list of additional survey 
data files will be merged with the main survey file to form the new, merged survey data file.  The 
merged survey data file contains all the collected data points along with the placed and 
discovered access points from all the existing survey data files.
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The “Force Access Points found in each Survey File to be unique” option is usually only checked 
when performing an initial site survey using a single portable access point to represent many 
different access points in a survey area.  By checking this option, even if the same access point is 
used in two or more survey files, the access point is treated as if it were a different access point. 
In other words, the data points from different survey files aren't merged under the same access 
point even if they were collected from the same access point.  This allows you to collect data 
with your single access point in one location, then move the access point to a new location and 
collect data in a separate survey file.  Then you can merge your results together into a single 
survey file and still see the reports as if you had many different access points placed throughout 
your survey area.  

Note that the access point is forced to be unique by slightly changing the MAC address of the 
conflicting access points.  The first octet of the first conflicting MAC address is labeled “GG”. 
A second conflicting MAC address is changed to start “GF”.  This continues through the 
alphabet.

One restriction does exist on which survey data files can be merged: The same image file must 
have been used in all of the survey files. The program will prevent you from proceeding with the 
merge if it detects that different survey map image files were used.

3.8 Generating Google Earth Reports
Once you have collected survey data, you can create a Google Earth KML file to visualize your 
wireless coverage.  This feature supplements the reports  built into VisiWave.  The exported data 
can be directly loaded into Google Earth for viewing.  Using the Google Earth viewer, you can 
see the signal strengths and coverage areas of all wireless networks surveyed.  This is overlaid on 
the Earth’s surface.  You can visualize data over any geographic area from an entire state down 
to an individual building.

3.8.1 Requirements

Before you can generate a Google Earth report, you need to make sure you have associated a 
survey map image with your survey data and that the top of the survey map image points north. 
You must also specify the latitude and longitude of at least one data point.  And, you must make 
sure your Scale value is accurate.  You will also need the free, Google Earth application installed 
on your computer to view the reports.

● Image File
When creating a survey file, set the survey map image in the Survey Properties dialog.

● Setting the Latitude/Longitude
If you collected some or all of your data using a supported GPS device, then this is 
already done for you.  But if you used either the Point-by-Point or Continuous capture 
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modes, you must specify the GPS coordinates of at least one data point.  You do this 
using the Set GPS Location menu item under the Survey menu.

● Scale
If the Scale value associated with the survey map is not correct, you will have to fix the 
scale before generating the report.  You can do this by simply changing the Scale value by 
selecting the Set Scale menu item under the File menu.  Changing this value will 
automatically update all the positions of the data points already collected.

● Google Earth
You can freely download the Google Earth viewer by going to http://earth.google.com. 
You can also purchase the more advanced versions for a fee.  You will need version 4.1 
or later.

3.8.2 How to Generate a Google Earth Report

Start the VisiWave Site Survey data collection application.  Load the survey file that already has 
the collected survey data.  From the File menu, select Generate Google Earth Report.  In the 
dialog box that comes up, you have many choices to help you visualize exactly what you need. 
Each option is explained below.

Once the Google Earth file is created, you can load it in the Google Earth application using the 
Open menu under File.  Your file will show up in the list on the left of the screen.  Click on the 
plus sign next to your file to expand what is inside your file.  Continue expanding items until you 
see everything you need to see.  Put a check next to any item you want Google Earth to show 
you.  Very little is checked initially.  This is to keep the display as uncluttered as possible.  It is 
best to just include the minimum amount of data that you need at any one time.

3.8.3 Report Options

When generating a report for Google Earth, you have many options.  The options are split up into 
three sections: Wi-Fi Data, Spectrum Data, and General Settings.  If either Wi-Fi Data or 
Spectrum Data is grayed out, that means that your survey file doesn’t contain any of that type of 
data.

Wi-Fi DATA

Include 3D Coverage Graphs

Putting a check next to this option will include a 3D coverage graph for each access point 
included in the report.  This coverage graph looks like a large tent over the area where the access 
point was observed.  The height of the tent is relative to the recorded strength of the signal.
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Label Grid Points

Selecting this option will place markers at regular intervals over the entire surface of the 3D 
Coverage Graph.  Hovering your mouse over the marker or clicking on the marker will give you 
detailed information about the coverage at that location.

Label Estimated AP Locations

Have VisiWave estimate the location of each access point included in the report.  VisiWave uses 
the collected data points to estimate the locations.  The more data points collected, the more 
accurate these positions will be.  Each access point is represented by an icon and each icon can 
be clicked on to see more information about that access point.

Include Collected Data Points

By checking this option, you will include a marker for each data point collected that contributes 
to that access point’s coverage map.  Each access point included in the report will have its own 
set of data point markers.  Hovering  your mouse over the marker or clicking on the marker will 
show you detailed information about that data point.

Include Contour Map Overlays

Select this option if you would like to include a 2D contour map overlay for each access point 
included in the report.  The contour map is the same map created using VisiWave Report.  It 
shows the signal strength using colored contour bands.  Each map is placed over top of the 
earth’s surface within Google Earth.  The map is slightly transparent so you can still see Google 
Earth’s satellite imagery.

Include Interference Graphs

This option lets you include a 3D graph much like the 3D Coverage Graph except that it 
represents the noise (or interference) in the survey area.  The noise level is usually only available 
if you used a Wi-Spy device while collecting Wi-Fi data during the survey.  Just having the Wi-
Spy plugged in while collecting Wi-Fi data will cause the noise levels to be recorded.  Otherwise, 
the noise level is usually just set to -100dBm.

Min. Signal Strength (3D Graphs)

You can specify the lowest signal strength that you want included in your 3D Coverage Graphs 
using this setting.  For example, if you don’t want to consider areas with a signal strength less 
than -90dBm as having a signal, then set this value to “-90”.  This setting only applies to the 3D 
Coverage Graphs (“coverage tents”) and their grid points.
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APs to Include

This option is the same as the one found in the VisiWave Report application.  It allows you to 
select either all access points or any subset of the collected access points.  If you don’t select any 
access point (or if you select all access points), then your Google Earth report will contain details 
about every access point seen during the survey.  If you select one or more individual access 
points, then only those access points are included in the report.

To keep the size of the Google Earth file small, it is recommended to carefully select only the 
access points that are necessary for your needs.

What to Graph

Use this option to select how you want to group access points.  You can have each AP’s coverage 
graph and associated data included individually by selecting “Each AP”.  You can add a new 
coverage for each SSID that combines all the APs from that network by selecting “APs Grouped 
by SSID”.  And you can add a single, overall coverage graph that includes all the APs by 
selecting the “All Combined” option.

If your report files are getting too large for Google Earth to handle, you should unselect the 
“Each AP” option and opt for one of the options that just creates graphs of grouped access points. 
These report files will then be considerably smaller.

In each case, only the access points included in the APs to Include option are used.

SPECTRUM DATA

Include 3D Coverage Graphs

Putting a check next to this option will include a 3D coverage graph for each 802.11 channel you 
select.  This coverage graph looks like a large tent over the survey area.  The height of the tent is 
relative to the recorded strength of the signal.  So, for spectrum data, the lower the tent, the 
better.

Label Grid Points

Selecting this option will place markers at regular intervals over the entire surface of the 3D 
Coverage Graph.  Hovering your mouse over the marker or clicking on the marker will give you 
detailed information about the interference at that location.

Include Collected Data Points

By checking this option, you will include a marker for each data point collected that contributes 
to that channel’s interference map.  Each channel included in the report will have its own set of 
data point markers.  Hovering your mouse over the marker or clicking on the marker will show 
you detailed information about that data point.
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Include Contour Map Overlays

Select this option if you would like to include a 2D contour map overlay for each channel 
included in the report.  The contour map is the same map created using VisiWave Report.  It 
shows the noise level using colored contour bands.  Each map is placed over top of the earth’s 
surface within Google Earth.  The map is slightly transparent so you can still see Google Earth’s 
satellite imagery.

Channels to Include

Select one of the options to specify which channels to include in the report.  Selecting 
“Combined Channels” will include a single view of the interference data where all frequencies 
across all channels are combined.  Selecting “Each Channel” will show each of the 13 802.11b/g 
channels as independent graphs.  Selecting “Both” will show both the individual channels and a 
combined view.

Graphing Maximum or Average Interference

Select between including a view of the maximum interference found over each range of 
frequencies or the average interference found over each range of frequencies.  In general, 
selecting “Max Interference” will result in values much higher than selecting “Average 
Interference”.

Min. Signal Strength (3D Graphs)

You can specify the lowest signal strength that you want included in your Interference Graphs 
using this setting. For example, if you don't want to consider areas with a signal strength less than 
-90dBm as having interference, then set this value to "-90". This setting only applies to the 3D 
Coverage Graphs ("coverage tents") and their grid points.

GENERAL SETTINGS

Include Image Map as an Overlay

You can include your survey map image used to collect the survey data as an overlay in the 
Google Earth file as well.  Only one copy of the image is included for the entire survey.  This 
image is slightly transparent by default so you can see the topography beneath it.  This is 
particularly useful if you collected data using a building’s floor plan image, but also can be useful 
for most any other type of survey.

Height of Graphs

This option affects the height of the 3D Coverage Graphs and the Labeled Grid Points.  If you are 
not planning to load the results of multiple surveys within Google Earth at one time, then using 
the option “Optimized for this Survey Area” should be selected.  This will scale the height of the 
graphed data to a value that matches the size of the survey area.
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If you plan on viewing the results of multiple surveys at the same time within Google Earth--for 
example, you may have performed surveys on several different neighboring cities and you want 
to view them all together—then you should select one of the other three options.  If your data sets 
all cover survey areas about the size of a building or a city block, then you should select 
“Suitable for Building-Sized Areas”.  If your survey areas are more the size of average sized 
cities, then you should select “Suitable for Small Cities”.  If your surveys cover any size larger 
than an average city, select “Suitable for Large Cities”.

Detail Level

The Google Earth report files can get quite large.  To keep the size of the report file smaller and 
to improve the performance of Google Earth, you should set the detail level to the smallest value 
that still gives you the detail that you need.  The highest detail level (”Most”) will divide the 
survey area into about 8,000 cells.  The lowest detail level (”Least”) will divide the survey area 
into about 100 cells.

Auto-Launch Google Earth File Viewer

Checking this option will automatically launch Google Earth after the report is generated and 
load the new data file inside Google Earth.  Or, if Google Earth is already running, it will just 
load the new data file within Google Earth.  If you are prompted by Google Earth to re-load the 
file, then select “Yes”.
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Chapter 4.0 Report and Analysis

4.1 Overview
After the survey data is collected, it is time to visualize your wireless network coverage. 
VisiWave Site Survey allows you to interactively visualize the survey data as well as create a 
detailed, permanent record of the site survey.

The interactive reporting view allows you to quickly visualize the large sampling of data that was 
just collected.  You can create heatmaps, interference heatmaps, AP coverage maps, channel 
maps, data rate maps, AP lists, value charts, and many other effective data visualizations.  All of 
these different views can then be used to troubleshoot connectivity issues, view your wireless 
coverage, or analyze coverage changes resulting from the adjustment of access point locations.

You can also use these views along with other supporting material to produce a detailed report of 
your wireless network coverage.  This report serves as a permanent record of the characteristics 
of your wireless network.  A full report can be accomplished with just a few simple steps or a 
highly customized report can be made with just a little more effort.

4.1.1 What is a Report?

The VisiWave Site Survey product is used to interactively analyze survey data and to create 
permanent documents that report the details of the site survey.  The permanent documents are 
referred to as reports.

A report consists of a list of report items.  A report item can be thought of as a page of the report 
(although a single item might physically take up more than one page).  Each report item has a 
certain report type and has a set of properties.  Examples of report types are title page, heatmap, 
channel map, survey overview, and image.  Each type of report has a different set of properties. 
You customize the output of a report item by changing its properties.

Whether you are creating a report or doing interactive analysis of survey data, you will create 
report items.  When analyzing survey data, an actual report may not be generated.  But the steps 
taken to create a page of a report and to do analysis of survey data are the same.  You first create 
a report item of the appropriate report type, then you customize the report item’s properties, then 
you view the results.  Often the report items used for analysis become pages in a report.

After creating a list of report items, you save the report as part of the VisiWave survey file.  The 
list of report items and all their properties are saved in this file.  A survey file contains almost 
everything needed to reproduce the report again in the future.  It does not contain some of the 
external items like survey map images and external image files included in the report.
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To create a full report, you create several report items, list them in the appropriate order, and then 
output the report.  You can include as many report items in a report as you wish.  And you can 
include the same report type in the report as many times as you wish.  The report is output as 
either an HTML document or as a Portable Document Format (PDF) file.  See Section 4.6 
Generating a Report for more information on each of these formats.

4.1.2 Creating a Report

To start creating a report or to view your survey data, click on the View|Report View menu item 
or click on the Report View icon in the toolbar.  You are presented with a new screen that allows 
you to easily create and view reports.  You can switch back to the view that allows you to collect 
survey data at any time by clicking on the View|Survey View menu item or clicking on the 
Survey View icon in the toolbar.  The survey view allows you to collect and edit survey data 
while the report view allows you to view and analyze the data you've collected.

The report view is divided into two panels.  In the left panel, you add report items and select their 
properties.  In the right panel, you see what the report item looks like.  In this section, we will go 
over more details about how to create reports and view your data.  We will do this by going over 
each area of the screen.
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Figure 7 - Report View
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Report Items

Figure 8 - Report Item List

In the upper left corner is the list of report items that are currently included in the report.  The 
entries are divided into two sub-lists: Quick Views and Report Items.  In a new survey, only the 
Quick Views list has anything under it.  It will always contain the core set of report types.  Click 
on any one of these items to see that view of the survey data.  These Quick Views are used as a 
starting point for building reports.  The only way to add pages to your report is to click on an 
existing item and add a copy of it to the report.  If you have a set of report properties that you use 
frequently, then set these in the Quick Views item so each time you base a new item off of this 
one it already has those properties set.  For example, if you always want to create heatmap graphs 
that map signal strength instead of signal-to-noise ratio, then set that in the Heatmap item under 
Quick Views.  Then any item you create by copying this report item will already have this 
property set.

The other sub-list is called Report Items.  This is a list of items that you've created that will be 
included in your report.  Items under Quick Views are never included in a report, but all items 
under Report Items with a check mark next to them will be included in any report you generate.

To add items under Report Items, you click on any existing item (either under Quick Views or 
Report Items) and press the Add to Report button.  A copy of that item is added to the end of the 
report.  You can now change this new item's properties to customize it however you wish.

You can also right-click on a report item and use the Cut/Copy/Paste menu items to add or 
move more report items.  The Duplicate menu item also adds an exact copy of the current item 
right below the item in the list.  Additionally, you can move an item by dragging and dropping it 
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to a new location in the list.  Or you can create a copy of an item by pressing and holding the Ctrl 
key while dragging and dropping it to a new location.

Report Item Properties

Figure 9 - Report Item Properties

Underneath the list of report items are the properties associated with the currently selected report 
item.  This list of properties updates whenever you click on a new report item.  You can change 
the properties to change how the report data is presented.  To do this, click on the property value. 
Hover your mouse over the property to view a helpful hint that briefly describes the purpose of 
the property.  For a more detailed description of what each property does, read the section that 
describes that report item.
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AP Filter

Figure 10 - AP List

Most report items allow you to select a subset of access points that you want to include in the 
report.  The AP Filter area allows you select exactly which APs are included for the currently 
selected report item.  This list can also be thought of as a report item property since it is specific 
to the currently selected report item.  When you select a different report item, the AP Filter for 
that report item is displayed.  Note that many reports won't display anything at all unless at least 
one AP is selected.

Note that you have the ability to give an access point a name that is meaningful to you.  To do 
this, just click on the AP in the AP Filter list and press F2 or click on the AP a second time.  In 
either case, you are given the ability to replace the default name with one of your own.  The name 
you pick can then be used as labels on your reports.  This is referred to there as the “Name”.  If 
you change your mind, just edit the name again and clear out the value.  The default name will 
then return.  You can also hover your mouse over any renamed AP to see the full description of 
the AP.
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Graph Display Area

Figure 11 - AP List

The entire right side of the window is used to display the currently selected report item.  This 
might be a heatmap graph as shown here or a table of information or whatever else is needed to 
render the selected report item.  You can resize the window to make the graph larger or smaller. 
You can also use the mouse to click and drag a boundary around an area on the graph to zoom in 
on that area.  The zoomed in area is the only part that is included in the report for that item.  To 
unzoom (view the entire graph), select the Unzoom icon in the toolbar.

4.2 Creating Your First Report
As a quick introduction to creating reports, we will walk through the steps needed to create a 
simple report.  To begin with, you will need to collect some survey data.  See the earlier sections 
on how to perform a site survey and collect survey data.  Once this is done, click on the Report 
View icon in the toolbar to switch to the report view.  You need to add some report items to your 
report and possibly change some report item properties or set the AP Filter.

First, click on the Title Page report item under Quick Views in the upper left panel.  Then press 
the Add to Report button.  This copies this item to the sub-list under Report Items.  Below the 
report item list is a set of properties for the Title Page.  Click in the entry field next to Report 
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Title.  Enter an appropriate title such as “My First Site Survey Report.”  Then press tab to move 
to the Subtitle/Author field.  Enter your name in that field.  Next select “Current Date” for the 
Include Date property.  Under Layout, set it to “Bottom center image”.  As you make these 
changes, your title page starts to form on the right side of the page.

Now add a second report item.  This time click on the Heatmap item under Quick Views.  And 
again press the Add to Report button.  Now this item is copied to the end of the Report Items list. 
You should only see your survey map image displayed on the right side of the window.  To 
create the heatmap that shows your coverage, you will need to select some access points in the 
AP Filter list in the lower left panel.  To do this, put a check mark next to either an entire 
network (SSID) or open up one of the network lists by clicking on the plus sign next to its name 
and then select one of the individual APs under that network.  Once you select at least one AP, 
the coverage heatmap should be drawn on the right over-top of your survey map.  See the figure 
below for an example of how it should look.
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Figure 12 - Example report after adding a heatmap and selecting an AP.

Next, let's add an AP Coverage item.  Click on AP Coverage under Quick Views.  Then press on 
Add to Report.  Again, just your survey map image will appear in the left panel until you select 
some access points to include.  Select two APs under AP Filter.  Two colored areas will appear 
overlaid on your survey map.  Each color represents one of the APs.  By default, the estimated 
location of each selected AP is shown as a bull's eye icon.  And each colored area is labeled by 
either it's AP number or by the name you gave that AP.  These colored areas show where each 
AP has the strongest signal.  The entire graph may not be colored.  This is due to two factors. 
The first is that areas that don't have at least the Minimum SNR (defaults to 8) won't be filled in. 
And the second is that areas where not enough data was collected also won't be filled in.  In the 
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figure below, AP#1 is strongest in the green areas and AP#13 is dominate in the gray areas.  The 
clear areas either didn't have any data points collected there or the signal to noise ratio for both 
AP#1 and AP#13 were below 8dB.

Figure 13 - Example of an AP Coverage graph with two APs selected.

To conclude this simple example, let's generate a report based on what we've added so far.  To do 
this, simply click on the Generate Report button in the bottom left corner of the window.  The 
window below appears.
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Figure 14 - Window for generating a report.

At the top enter the filename where you want to save the new report.  In this case we are 
generating a PDF report, but HTML reports can also be created.  Use the default options in the 
bottom half of the window.  Press OK to create the report.  You are shown the progress as the 
report is generated.  Since we had a check mark in the “View After Completion” option, the PDF 
document is automatically loaded and displayed by the program your computer has configured to 
handle PDF files.

This has been a simple and quick example of how to create a report using VisiWave.  Next this 
guide will cover each report type in detail.  Then the guide concludes by going over various 
product features.

4.3 Report Types
VisiWave currently has eleven different core types of reports: Title Page, Survey Overview, AP 
List, Heatmap, Interference Heatmap, AP Coverage, Channel Map, Data Rate Map, Survey Map, 
Value Chart, and Image.  These can be grouped into two categories: organizational report types 
and graph report types.  The organizational report types are Title Page, Survey Overview, and AP 
List.  These either help you create a more organized report or they provide detailed lists of 
information available in the report.  All the other report types are graphical.  They visually 
display information about your wireless network.
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In this section, the purpose of each report type is described as well as every property of the report 
type.

4.3.1 Common Report Properties

Several properties appear in almost all report types.  These common properties will be covered 
here rather than described separately under each report type.

Title

The Title property allows you to include a descriptive title that appears at the top of that graph's 
page.  It isn't displayed on-screen, but it will appear in any PDF or HTML report that you 
generate.  If you don't set the title, then VisiWave will create an appropriate title for you.

Description

The Description property is used to include a few lines or paragraphs of text that describes this 
particular report page.  Just like the title, the description is only included in generated PDF or 
HTML reports.

Figure 15 - Window for editing the description.

You can easily enter a short description right in the field next to the Description property.  Or you 
can click on the “...” button next to it and bring up a bigger window (shown above) where you 
can more easily enter a longer description (or paste in a description that was written elsewhere). 
This window also lets you choose where you want the description displayed on the page.  You 
can select between including the description at the top of the page (above the graph) or at the 
bottom of the page (below the graph).  If you have a long description, it may not appear on the 
same page as the graph.  If you have a short or medium length description and you want it at the 
top of the page, VisiWave may shrink your graph slightly to allow everything to remain on the 
same page.
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Caption

The Caption property is included for every report type that includes a graph.  The text entered for 
this property is included directly underneath the graph on the report page.  It is not shown on-
screen, but only in generated PDF or HTML reports.  And if left blank, VisiWave will include an 
appropriate default caption for each graph.

Zooming in on the Survey Map

This “property” isn't listed along with all the other report properties, but it is still a useful 
property to know about.  You have the ability to zoom in on a specific area of the survey map and 
include only that area in the report.

By default, the entire survey map is shown for a graph.  If you want to only include a subset of 
the survey area—maybe highlight the coverage in a single room—then you can zoom in on that 
area by clicking and holding the button on your mouse while dragging the mouse pointer across 
the region you want to zoom in on.

Figure 16 - Example of zooming in on a small region of the survey map.

Once you release the mouse button, the map is redrawn including just the region you selected. 
To undo this zoom, click on the Un-Zoom button in the toolbar.

4.3.2 Title Page

The main purpose of the Title Page report type is to allow you to include a title page as the first 
page of your report.  You can include it anywhere—to separate sections of your report, for 

VisiWave Site Survey User's Guide 44



example.  But most reports will have it as the very first page.  The title page allows you to 
include an image as well as a title, author, and date/time.  But any of these can also be omitted.

Note that the AP Filter has no affect on a title page.

Report Title

This text field is set to the main title of your report (or report section).  It is presented in the 
largest, bold font on the page.  What you enter here is always treated as a single line.  If the text 
is very long, VisiWave will use a font small enough to show the entire text on a single line.  If 
your title is too small to read, you may need to shorten it.

Subtitle/Author

This text field appears below the Report Title and is a slightly smaller, non-bold font.  It's 
intended to contain either the report's subtitle or author, but you can include any text you would 
like.  Again, the entire value will fit on only one line so long subtitles will use a small font.

Include Date

If you wish to have VisiWave automatically add the date to the title page, set this to the 
appropriate value.  You can include either the date and time when the survey was first created or 
the date and time when the report is printed.  The time is optional.

Image File

If you wish to include an image on your title page, set this to the path and filename of an image 
file.  Supported image types include JPEG, PNG, GIF, and BMP.  Note that this image file is not 
included within the survey file itself so whenever this report is created, this file must exist on the 
local computer in the same folder or the image won't be included.

To control where the image appears, use the Layout property described below.

Image Width

This property controls how big the image will appear on the page.  The value indicates the width 
of the image as a percentage of the page width.  For example, “50” would mean the image is as 
wide as half the width of the page.  And “25” would mean the image is a quarter of the page 
width.  The height of the image is adjusted as well to maintain the image's aspect ratio.  Note that 
the height may become taller than the size of the page.  In this case, the top and bottom of the 
image is not displayed.

Layout

Where the image and title is included on the page is determined by the page's layout.  The Layout 
property indicates where the image is located on the page.  Title is always located in an 
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appropriate place based on where the image is.  For example, if you select “Left center image”, 
then the image is placed along the left side of the page, centered top-to-bottom and the title is 
placed on the right side of the page—in however much space is left over once the image is 
included.

4.3.3 Survey Overview

This report type allows you to include many different statistics and some overview information 
about the site survey.  It is presented as a table of information that consists of four different 
categories.  You can select just which categories you want to include.

Title and Description

See above for more about the Title and Description properties.

Overview Items to Include

The overview information is split into four categories.  Put a check mark next to all of the 
categories that you want to include.  Each category is described here.

Survey Description: This is information entered by the surveyor at the time the survey was 
done.

Survey Location:  This is the location information entered by the surveyor at the time the survey 
was done.

Survey Information: This includes many statistics calculated from the survey data that was 
collected.  Some of the values take the AP Filter into consideration.  For example, the number of 
Wi-Fi data points collected just includes the data points that include at least one AP from the set 
of APs included in the AP Filter.

Number of Wi-Fi Data Points: This is the total number of data points collected.  The AP 
Filter is used.  Only data points that contain at least one AP from the APs selected 
in the AP Filter are counted.

Number of Data Points (Associated): This counts the number of data points that were 
associated with an AP from the set of APs selected in the AP Filter.

Number of Spectrum Data Points: This counts the total number of spectrum data points 
collected (independent of the AP Filter).

Number of AP Readings Taken: This is the sum of all the APs seen at each data point. 
Only APs selected in the AP Filter are counted.
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Ave Number of APs Seen at each Point: This is simply the Number of AP Readings 
Taken divided by the Number of Wi-Fi Data Points.  Note that both of those 
values take the AP Filter into consideration.

Channels Seen: This is a list of all the channel numbers seen in the survey from any of the 
APs selected in the AP Filter.  In parenthesis is the percentage of AP readings 
seen using that particular channel.

Data Rates Seen: This is a list of all the data rates seen in the survey from any of the APs 
selected in the AP Filter.  In parenthesis is the percentage of AP readings seen 
using that particular data rate.

Security Modes Seen: This is a list of all the security protocols seen in the survey from 
any of the APs selected in the AP Filter.  In parenthesis is the percentage of AP 
readings seen using that particular security mode.

Confidence Radius: This is the length of the confidence radius used throughout this 
report.  The confidence radius tells VisiWave the distance around each collected 
data point that should be considered reliable.

Number of APs Discovered: Total number of APs discovered throughout the survey. 
This ignores the AP Filter.

Total Number of Points:  Total number of data points collected.  This ignores the AP 
Filter.

Survey Trail Length: The length of the survey trail (the path taken while collecting data 
points).  This ignores the AP Filter.

Distance Between All Data Points: This is similar to the Survey Trail Length but it also 
takes into account point-by-point data points.  It is the length of the survey trail 
plus the distance of each point-by-point data point to its nearest neighboring data 
point.  This ignores the AP Filter.

Ave Distance Between Data Points: This is the Distance Between All Data Points divided 
by the Total Number of Points.  This ignores the AP Filter.

Total Survey Area: Taking the confidence radius into account, this indicates the square 
feet or square meters of area covered by the survey.

Lat/Long of Survey Area Center:  The center point of the entire survey area given as the 
latitude and longitude (assuming the GPS location has been set).

Percentage of Survey Map Covered: The Total Survey Area divided by the area covered 
by the survey map.
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Surveyor Notes: These are any notes entered by the surveyor while the survey was being 
performed.

4.3.4 AP List

The AP List page contains a table of all APs discovered during the survey.  The table contains 
information about each AP including the SSID, AP# (assigned by VisiWave), user-assigned 
name, MAC address, channel, security mode, average signal-to-noise (SNR) ratio, maximum 
SNR, minimum SNR, number of data points collected when the client was associated with that 
AP, and the number collected when not associated with that AP.

Using the AP Filter, you can select exactly which APs you wish to include in the table.

Listed here are all of the properties that affect the AP List.

Title and Description

See above for more about the Title and Description properties.

Sort by

Use this property to select which column is used to sort the table.  For example, select MAC to 
sort the list by MAC address.  As a shortcut, you can just click on the column heading and this 
property will be changed to the column heading you clicked on.

Secondary Sort

This property lets you have a second sort key that is used whenever the primary sort field has the 
same value.  For example, if the “Sort by” property is set to SSID and the Secondary Sort 
property is set to “MAC” then whenever there is more than one AP with the same SSID, they are 
first grouped by SSID and then sorted by MAC address.  As a shortcut, you can hold the shift-key 
and click on a column heading to change this property to the column heading you clicked.

4.3.5 Heatmap

The heatmap report item creates a graph with an AP's coverage overlaid on top of the survey 
map.  The strength of the coverage is indicated by color regions and shades within each color.  If 
you are using the default colors, blue areas have the highest signal strength.  Green areas have a 
medium signal strength.  And brown/gold areas have the weakest signal strength.  Within any of 
these colors, the lightest shade of that color has the higher signal strength and the darker shades 
have the weaker signal strength.

Initially only the survey map is displayed when a heatmap graph is selected.  This is because no 
APs have been selected for inclusion in the AP Filter list in the lower left panel of the window. 
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Usually the first thing you do when adding a heatmap graph is select one or more APs that you 
want included in the coverage graph.  If you select more than one AP, the coverage of each AP is 
combined using the signal from the strongest AP for each location graphed.

Color Legend

The color legend is along the bottom of the screen below the survey map.  You can set the 
minimum and maximum signal strengths, the signal strength boundaries between the three 
colors, and each of the colors used in each region.

To the left of the legend is a field labeled “Min.”.  This sets the signal strength lower boundary 
for the leftmost color region.  For example, if you set this to 8, then the darkest shade of the 
leftmost color will also include all areas with a signal strength of 8dB or less.  If you set this to 
zero, then whatever the lowest signal level found in the survey data is used as the lower bound.

To the right of the legend is a field labeled “Max.”.  This sets the higher boundary for the signal 
strength for the rightmost color region.  For example, if you set this to 65 then the lightest shade 
of the rightmost color will also include all areas with a signal strength of 65dB or greater.

To change the two internal boundaries, click on one of the tabs in the legend and drag it to the 
new location.  The number on the tab indicates the new boundary in either dBm or dB.  The tab 
might not land exactly on the edge of a color region.  This is due to the fact that each region is 
made to be the same size and not all region edges fall on a whole number boundary.

To change the base color of one of the three colored regions, right click on one of the three 
colored regions in the legend and select the Edit Color menu item.  Then select the new color 
from the window that appears.  This is then saved for this report item—but not for other report 
items that already exist.

Title, Description, and Caption

See above for more about the Title, Description, and Caption properties.

Value To Graph

This property lets you select the signal value you want to graph in the heatmap.  It can be one of 
the following: signal-to-noise ratio (SNR), signal, noise, receive errors, transmit errors, 
collisions, multi-collisions, and round-trip-times (RTT).  Note that receive errors, transmit errors, 
collisions, multi-collisions, and RTT can only be graphed for the associated AP.  This 
information can only be collected when associated with an AP.

Color Bands

This property sets the number of color bands displayed in the heatmap.  This is the same as the 
number of shaded regions seen in the legend at the bottom of the screen.  Note that this number is 
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approximate.  The actual number of color bands might be a few more or a few less.  This is in an 
effort to make the boundary values (the two tabs) fall as close to a whole number as possible.

AP Locations

This tells VisiWave to add a marker on the graph that estimates the location of each AP selected 
in the AP Filter.  If this is set to “Icon” then just an icon is placed at the estimated location for 
each AP.  Selecting “Icon + Name”, “Icon + AP#”, or “Icon + SSID” will place the marker on the 
graph and include a label just above the marker that identifies which AP the marker belongs to. 
Or you can select “Don't Mark” which means the estimated locations are not included on the 
graph.  Note that for graphs with many APs, it will take noticeably longer to draw the graph 
when the markers are included.

Show AP Markers

If you want to see the access point markers that you set while collecting survey data, then set this 
to “Yes”.  A marker (a red circle with an “X” in it) will be placed on the survey map.  If you also 
want to label the marker with the name you gave the marker, then select “Yes, with labels”.

Overlay Data Points

If you wish to show markers overlaid on the graph where each data point was collected, then this 
property allows you to do that.  You can select “Wi-Fi Data” to only mark where Wi-Fi was 
collected.  Selecting “Spectrum Data” will mark just where spectrum data was collected. 
Selecting “All” will include all data points.

Transparency

You can customize how transparent the coverage graph overlay is by setting this value.  This 
value actually sets the opacity of the overlay graph.  Setting this to zero means it is 100% 
transparent (invisible).  Setting it to 100% means it is completely opaque (which means you 
won't be able to see your survey map underneath it at all).  A value around 67% is usually a 
reasonable degree of transparency.

4.3.6 Interference Heatmap

An interference heatmap is exactly like a regular heatmap described above except its default 
values are better suited for graphing spectrum interference levels than Wi-Fi coverage levels. 
Because this type of heatmap graph is so similar to a regular heatmap, only a few differences will 
be discussed here.  For more information on how to customize an interference heatmap, please 
see the regular heatmap section above.

With interference heatmaps, the default boundaries for the legend is zoomed in on the lowest 
acceptable signal strengths since typically this is where most interference readings fall.  You can 
change this at any time by dragging the tabs in the legend left or right.
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With interference graphs, under AP Filter you will want to select a frequency range under 
“2.4GHz Spectrum Data” or “5GHz Spectrum Data”.  This is different from regular heatmaps 
where you normally select a subset of APs instead of frequency ranges.

4.3.7 AP Coverage

An AP Coverage map shows you the wireless coverage of one or more access points.  It does this 
by assigning a unique color to each AP and coloring the area on the map that is covered by that 
AP.

Initially only the survey map is displayed when an AP Coverage map is selected.  This is because 
no APs have been selected for inclusion in the AP Filter list in the lower left panel of the 
window.  Usually the first thing you do when adding an AP Coverage map is to select one or 
more APs that you want included in the map.  You can select as many APs as you wish, but 
selecting more than five or ten can result in a very cluttered coverage map.  Select as few as 
possible and consider adding multiple coverage maps instead of putting too many on a single 
graph.  Also, there are only about 100 unique colors to assign to the APs so once you have more 
than this, the colors might repeat.

The example below shows you the coverage area of the six APs selected in the AP Filter.  In this 
case, only the area where the AP has the strongest signal is shown.  You can also have VisiWave 
show you the entire coverage area of each AP.
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Figure 17 - Example of an AP Coverage map.

Title, Description, and Caption

See above for more about the Title, Description, and Caption properties.

What To Map

This property lets you choose between showing just the strongest AP in any given area or to 
show the entire coverage area of the AP.  When only one AP is selected, there is no difference 
between the two.  But when more than one AP is selected, the results can be quite different. 
Selecting Strongest APs will never have any overlapping colored areas.  Each location is painted 
with the color of the strongest AP found at that location.  If Complete AP Areas is selected, then 
the entire coverage area for each selected AP is painted.  This can result in many overlapping 
colored areas.  The colors in the overlapping areas are blended together which can be difficult to 
interpret if more than two colors are involved.
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Here are two examples.  The left one is a graph with Strongest APs selected.  The right one has 
Complete AP Areas selected.  Each includes the same five access points.

Figure 18 - Left is Strongest APs, right is Complete AP Areas

Label APs

Each AP (colored region) can be labeled to help identify each coverage area.  You can pick 
between labeling it with the VisiWave assigned AP# (as is seen in the above figure), the user 
assigned name, the SSID of the AP, or no label at all.  In any case, the label is placed in the 
center of the total coverage area of the AP.  Note that it is not placed where VisiWave thinks the 
AP is located.

Minimum SNR

This property sets the minimum signal-to-noise ratio needed in a location to have it included in 
the AP's coverage area.  For each selected AP, any area with an SNR less than this is 
automatically excluded from the coverage area.  Note that the higher this number is, the smaller 
the coverage area will be.

AP Locations

This tells VisiWave to add a marker on the graph that estimates the location of each AP selected 
in the AP Filter.  If this is set to “Icon” then just an icon is placed at the estimated location for 
each AP.  Selecting “Icon + Name”, “Icon + AP#”, or “Icon + SSID” will place the marker on the 
graph and include a label just above the marker that identifies which AP the marker belongs to. 
Or you can select “Don't Mark” which means the estimated locations are not included on the 
graph.
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Show AP Markers

If you want to see the access point markers that you set while collecting survey data, then set this 
to “Yes”.  A marker (a red circle with an “X” in it) will be placed on the survey map.  If you also 
want to label the marker with the name you gave the marker, then select “Yes, with labels”.

Overlay Data Points

If you wish to show markers overlaid on the graph where each data point was collected, then this 
property allows you to do that.  You can select “Wi-Fi Data” to only mark where Wi-Fi was 
collected.  Selecting “Spectrum Data” will mark just where spectrum data was collected. 
Selecting “All” will include all data points.

Transparency

You can customize how transparent the coverage graph overlay is by setting this value.  This 
value actually sets the opacity of the overlay graph.  Setting this to zero means it is 100% 
transparent (invisible).  Setting it to 100% means it is completely opaque (which means you 
won't be able to see your survey map underneath it at all).  A value around 67% is usually a 
reasonable degree of transparency.

4.3.8 Channel Map

A Channel Map is used to show you the areas where each Wi-Fi channel is currently being used 
and any possible areas of conflict.  

Initially only the survey map is displayed when a Channel Map is selected.  This is because no 
APs have been selected for inclusion in the AP Filter list in the lower left panel of the window. 
Usually the first thing you do when adding a Channel Map is to select one or more APs that you 
want included in the map.  You can select as many APs as you wish, but selecting more than a 
few can result in a very cluttered coverage map.  Select as few as possible and consider adding 
multiple coverage maps instead of putting too many on a single graph.

The Channel Map looks at the channel used by each selected AP and the coverage area of that 
AP.  It then paints all the regions the same color that use the same channel.  If there is any 
overlap, then either the two or more colors are blended together or you can have these areas 
highlighted as red regions on the map.  Also you can optionally have each AP colored separately 
just like in the AP Coverage map, but the channel number is also displayed on the map for 
reference.

Title, Description, and Caption

See above for more about the Title, Description, and Caption properties.
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Colors Based On

Basing colors on “Channels” means that areas with the same channel are all painted the same 
color (regardless of what AP used that channel).  So if you have three APs on channel 6 and two 
APs on channel 11, you will end up with two areas each with their own color (not counting any 
overlapping areas where the colors are blended together).  Note that each channel has a specific 
color that is always the same from graph-to-graph.

Basing colors on “APs” means that each AP's coverage area is painted that AP's unique color. 
Each area's label includes both the channel number and AP#, but you can't tell what channel is 
used based solely on the color.

Label Channels

If you wish to have each colored area labeled, then set this to “Yes”.  The label consists either of 
just the channel number or the channel number plus the AP#.  In either case, the label is placed in 
the center of the total colored area.  Note that it is not placed where VisiWave thinks the AP is 
located.

Minimum SNR

This property sets the minimum signal-to-noise ratio needed in a location to have it included in 
the AP's channel map.  For each selected AP, any area with an SNR less than this is 
automatically excluded from the channel map.  Note that the higher this number is, the smaller 
the area will be.

Highlight Overlaps

Normally if two or more color regions overlap, all the overlapping colors are blended together.  It 
can be difficult to understand which area the blended colors belong to.  For channel maps, it is 
often interesting to know just where these overlaps are occurring—this may indicate areas of 
channel conflict.  To highlight these areas, set this property to the minimum number of 
overlapping areas that are needed to trigger the highlight.  All overlapping areas are then set to a 
bright red color.

AP Locations

This tells VisiWave to add a marker on the graph that estimates the location of each AP selected 
in the AP Filter.  If this is set to “Icon” then just an icon is placed at the estimated location for 
each AP.  Selecting “Icon + Name”, “Icon + AP#”, or “Icon + SSID” will place the marker on the 
graph and include a label just above the marker that identifies which AP the marker belongs to. 
Or you can select “Don't Mark” which means the estimated locations are not included on the 
graph.
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Show AP Markers

If you want to see the access point markers that you set while collecting survey data, then set this 
to “Yes”.  A marker (a red circle with an “X” in it) will be placed on the survey map.  If you also 
want to label the marker with the name you gave the marker, then select “Yes, with labels”.

Overlay Data Points

If you wish to show markers overlaid on the graph where each data point was collected, then this 
property allows you to do that.  You can select “Wi-Fi Data” to only mark where Wi-Fi was 
collected.  Selecting “Spectrum Data” will mark just where spectrum data was collected. 
Selecting “All” will include all data points.

Transparency

You can customize how transparent the channel map overlay is by setting this value.  This value 
actually sets the opacity of the overlay graph.  Setting this to zero means it is 100% transparent 
(invisible).  Setting it to 100% means it is completely opaque (which means you won't be able to 
see your survey map underneath it at all).  A value around 67% is usually a reasonable degree of 
transparency.

Channel Groups

Using the various channel groups, you can selectively include just a subset of channels you wish 
to view in the map.  For example, if you want to create a graph that only includes 5GHz 
channels, then you can easily select this subset and only those channels are included in the map 
even though APs that were using 2.4GHz channels were selected in the AP Filter.

You typically select either one or more channel groups (with names like “All 2.4GHz channels” 
or “All EU 5GHz channels”) or you select individual channel numbers under “2.4GHz Channels” 
or “5GHz Channels”.

4.3.9 Data Rate Map

A Data Rate Map is used to show you the areas where each Wi-Fi data rate is currently being 
used.  The data rate is the theoretical maximum throughput rate seen at each location when data 
was collected.  It isn't the actual measured throughput, but merely the maximum rate allowed by 
the current operating parameters between the AP and the survey client.

Initially only the survey map is displayed when a Data Rate Map is selected.  This is because no 
APs have been selected for inclusion in the AP Filter list in the lower left panel of the window. 
Usually the first thing you do when adding a Data Rate Map is to select one or more APs that you 
want included in the map.  You can select as many APs as you wish, but selecting many APs that 
use more than a few unique data rates can result in a very cluttered map.  Select as few as 
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possible and consider adding multiple Data Rate maps instead of putting too many on a single 
graph.

The Data Rate Map looks at the data rate used by each selected AP and the coverage area of that 
AP.  It then paints all the regions the same color that use the same data rate.  If there is any 
overlap, then either the two or more colors are blended together or you can have these areas 
highlighted as red regions on the map.  Also you can optionally have each AP colored separately 
just like in the AP Coverage map, but the data rate is also displayed on the map for reference.

Title, Description, and Caption

See above for more about the Title, Description, and Caption properties.

Colors Based On

Basing colors on “Data Rates” means that areas with the same data rate are all painted the same 
color (regardless of what AP used that data rate).  So if you have three APs with data rates of 
11Mbps and two APs with data rates of 54Mbps, you will end up with two areas each with their 
own color (not counting any overlapping areas where the colors are blended together).  Note that 
each data rate has a specific color that is always the same from graph-to-graph.

Basing colors on “APs” means that each AP's coverage area is painted that AP's unique color. 
Each area's label includes both the data rate and AP#, but you can't tell what data rate is used 
based solely on the color.

Label Data Rates

If you wish to have each colored area labeled, then set this to “Yes”.  The label consists either of 
just the data rate or the data rate plus the AP#.  In either case, the label is placed in the center of 
the total colored area.  Note that it is not placed where VisiWave thinks the AP is located.

Minimum SNR

This property sets the minimum signal-to-noise ratio needed in a location to have it included in 
the AP's data rate map.  For each selected AP, any area with an SNR less than this is 
automatically excluded from the data rate map.  Note that the higher this number is, the smaller 
the area will be.

Highlight Overlaps

Normally if two or more color regions overlap, all the overlapping colors are blended together.  It 
can be difficult to understand which area the blended colors belong to.  To highlight these areas, 
set this property to the minimum number of overlapping areas that are needed to trigger the 
highlight.  All overlapping areas are then set to a bright red color.
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AP Locations

This tells VisiWave to add a marker on the graph that estimates the location of each AP selected 
in the AP Filter.  If this is set to “Icon” then just an icon is placed at the estimated location for 
each AP.  Selecting “Icon + Name”, “Icon + AP#”, or “Icon + SSID” will place the marker on the 
graph and include a label just above the marker that identifies which AP the marker belongs to. 
Or you can select “Don't Mark” which means the estimated locations are not included on the 
graph.

Show AP Markers

If you want to see the access point markers that you set while collecting survey data, then set this 
to “Yes”.  A marker (a red circle with an “X” in it) will be placed on the survey map.  If you also 
want to label the marker with the name you gave the marker, then select “Yes, with labels”.

Overlay Data Points

If you wish to show markers overlaid on the graph where each data point was collected, then this 
property allows you to do that.  You can select “Wi-Fi Data” to only mark where Wi-Fi was 
collected.  Selecting “Spectrum Data” will mark just where spectrum data was collected. 
Selecting “All” will include all data points.

Transparency

You can customize how transparent the data rate map overlay is by setting this value.  This value 
actually sets the opacity of the overlay graph.  Setting this to zero means it is 100% transparent 
(invisible).  Setting it to 100% means it is completely opaque (which means you won't be able to 
see your survey map underneath it at all).  A value around 67% is usually a reasonable degree of 
transparency.

Include Rates >= / <=

Using these two properties, you can selectively include just the subset of data rates you wish to 
view in the map.  For example, if you want to create a graph that only includes rates less than or 
equal to 11Mbps, then set the “Include Rates Greater than or Equal to” property to 1 and the 
“Include Rates Less than or Equal to” property to 11.  Then only areas using those slower rates 
are included in the map even though APs that were using faster rates were selected in the AP 
Filter.

4.3.10 Survey Map

The Survey Map report type exists merely to show the basic survey area.  This view shows the 
survey map along with optionally including the estimated AP locations, survey data points 
collected, and the confidence area.  No coverage or heatmap is shown on this map.
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Note that the AP Filter has no affect on the survey map.

Title, Description, and Caption

See above for more about the Title, Description, and Caption properties.

Show Confidence Area

Enabling this property will paint a colored overlay on the survey map that shows the area where 
VisiWave considers the collected data to be sufficient to estimate coverage.  This is based on the 
confidence radius setting for this survey.

AP Locations

This tells VisiWave to add a marker on the graph that estimates the location of each AP selected 
in the AP Filter.  If this is set to “Icon” then just an icon is placed at the estimated location for 
each AP.  Selecting “Icon + Name”, “Icon + AP#”, or “Icon + SSID” will place the marker on the 
graph and include a label just above the marker that identifies which AP the marker belongs to. 
Or you can select “Don't Mark” which means the estimated locations are not included on the 
graph.

Show AP Markers

If you want to see the access point markers that you set while collecting survey data, then set this 
to “Yes”.  A marker (a red circle with an “X” in it) will be placed on the survey map.  If you also 
want to label the marker with the name you gave the marker, then select “Yes, with labels”.

Overlay Data Points

If you wish to show markers overlaid on the graph where each data point was collected, then this 
property allows you to do that.  You can select “Wi-Fi Data” to only mark where Wi-Fi was 
collected.  Selecting “Spectrum Data” will mark just where spectrum data was collected. 
Selecting “All” will include all data points.

Transparency

You can customize how transparent the confidence area map overlay is by setting this value. 
This value actually sets the opacity of the overlay map.  Setting this to zero means it is 100% 
transparent (invisible).  Setting it to 100% means it is completely opaque (which means you 
won't be able to see your survey map underneath it at all).  A value around 67% is usually a 
reasonable degree of transparency.

4.3.11 Value Chart

The Value Chart gives you a way to see the actual data values collected and where they were 
collected.  This is done by splitting the survey map up into many small cells.  You can then 
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optionally display various values collected within each cell.  You can set how many cells are 
created, what is included in each cell, and the presentation of the cell data.

Initially only the survey map is displayed with the cell grids drawn over-top when a Value Chart 
is selected.  This is because no APs have been selected for inclusion in the AP Filter list in the 
lower left panel of the window.  Usually the first thing you do when adding a Value Chart is 
select one or more APs that you want included in the chart.  If a cell is blank, that means no data 
points from any of the selected APs in the AP Filter were placed within that cell.

Title, Description, and Caption

See above for more about the Title, Description, and Caption properties.

Columns

This sets the number of columns to use across the width of the survey map.  Each cell is square 
so this also determines how many rows to include down the survey map.  The more columns, the 
smaller each cell will be, but the more granular the data you see.  Even if you are having troubles 
seeing all the information on-screen, you may still be able to see it just fine in the generated 
report since those images will probably be larger than what you see on-screen.

Font Size

This sets the size of the font that you would like to use to display the chart values.  However, if 
necessary, VisiWave may pick a smaller font if everything doesn't fit within any particular cell. 
The font size is in points (1/72 of an inch).

Font Size (min)

This is the minimum font sized used to display the values in the chart.  If VisiWave needs to pick 
a font smaller than the font size set above, then it won't pick a size any smaller than this.

Background Transparency

This value lets you customize how transparent the shaded background behind the text is. 
Actually, this sets the opacity of the text background.  Setting this to zero means it is 100% 
transparent (no background).  Setting it to 100% means it is completely opaque (which means 
you won't be able to see your survey map underneath the text background at all).  A value around 
75% is usually a reasonable degree of transparency.

Values Shown

This allows you to select just the values you want to include in each cell.  Obviously, the more of 
these you pick, the larger the cell will need to be to include them all.  If you need to include too 
many to clearly see their values, you may want to include more than one Value Chart in your 
report with each containing only a few of the desired values.
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Datapoint Count: This is a count of all the data points that include a reading from any of 
the selected APs in the AP Filter that fall within this cell.  The count is after the 
pound sign (“#”) in the cell.

Ave Signal: This is the average signal strength of all the data points from any of the APs 
selected in the AP Filter that fall within this cell.  This value is after “dBm” in the 
cell.

Ave SNR: This is the same as the Ave Signal except it lists the average signal-to-noise 
ratio.

AP#'s: This lists each of the AP#'s from any of the APs selected in the AP Filter that were 
captured within this cell.

Channels: This is a list of all the channels from any of the APs selected in the AP Filter 
that were seen in this cell.  This value is after “Ch” in the cell.

Data Rates: This is a list of all the data rates from any of the APs selected in the AP Filter 
that were seen in this cell.  This value is after “Rates” in the cell.

Security: This is a list of all the security protocols from any of the APs selected in the AP 
Filter that were seen in this cell.

Spectrum Max (2.4GHz): This is the average maximum interference from any of the 
2.4GHz frequencies selected in the AP Filter that were seen in this cell.  This 
value is after “Spec 2.4” in the cell.

Spectrum Ave (2.4GHz): This is the average interference from any of the 2.4GHz 
frequencies selected in the AP Filter that were seen in this cell.  This value is after 
“Ave” in the cell.

Spectrum Max (5GHz): This is the average maximum interference from any of the 5GHz 
frequencies selected in the AP Filter that were seen in this cell.  This value is after 
“Spec 5GHz” in the cell.

Spectrum Ave (5GHz): This is the average interference from any of the 5GHz frequencies 
selected in the AP Filter that were seen in this cell.  This value is after “Ave” in 
the cell.

Standard Deviations: Selecting this will add standard deviations to each of the average 
values that are already selected.  This gives you an idea of how varied the values 
are.  If all the values are close to each other within the cell, then the standard 
deviation will be a small value.  If the values are all quite different, then the 
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standard deviation will be larger.  This value is added to the same line as the 
average and is included after “s=”.

4.3.12 Image

This allows you to include in your report an image created outside of VisiWave.  You can 
include most any JPG, PNG, GIF, or BMP image.  For example, you may want to include some 
digital photos that you took at the survey site.  Or possibly some drawings of your network that 
were generated outside of VisiWave.

Title, Description, and Caption

See above for more about the Title, Description, and Caption properties.

Image File

This is the path and filename of the image file.  Supported image types include JPEG, PNG, GIF, 
and BMP.  Note that this image file is not included within the survey file itself so whenever this 
report is created, this file must exist on the local computer in the same folder or the image won't 
be included.

Maximize

If this is set to “No”, then the image is included in the report at its actual size—unless the image 
is too big to fit on the page in which case it is resized to fit.  If this is set to “Yes”, then the image 
is scaled to fill the page while still maintaining its native aspect ratio.

4.4 Report Items: Moving, Copying, Deleting, and Renaming
You have several options for reordering, copying, deleting or renaming report items.

One method is using drag-and-drop.  To reorder report items using drag-and-drop, select the 
report item you want to move.  While holding down the mouse button, move the mouse pointer 
to the report item that you want the selected item to be inserted after.  Now release the mouse 
button.  The selected item is then inserted after the item that is currently under your mouse 
pointer.  Similarly, you can copy an item using drag-and-drop.  To make a copy, press the Ctrl 
key while dragging the item to a new location.  After releasing the mouse button, a copy of the 
currently select item will be added.

You can also use cut-and-paste to reorder items.  To do this, select the report item you want to 
move, then either right-click on the selected report item to view the context menu or click on the 
Report menu.  From either menu, select Cut.  This removes the selected item and places it in the 
clipboard.  Now within the report item list select the report item above the location where you 
want the original report item to be moved to.  Again, access either the Report menu or the 
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context menu, then select Paste.  The item in the clipboard is now placed after the item that was 
selected in the report item list.

An item can also be reordered using the keyboard.  This is done very similarly to the reordering 
using the menu items.  To begin, select the item you want to move.  Then press either Shift-
Delete or Ctrl-X on the keyboard.  This puts the selected item in the clipboard.  Now select the 
item above where you want the item to be moved.  Then press either Shift-Insert or Ctrl-V.  The 
item in the clipboard is then inserted after the selected item.

Items can be copied using either the Report menu or keyboard in almost the exact same way you 
move items.  The only difference when using the Report menu is you use the Copy menu item 
instead of the Cut menu item.  When using the keyboard, the only difference is that you use 
either Ctrl-Insert or Ctrl-C to add the item to the clipboard instead of Shift-Delete or Ctrl-X.

Items can also be copied by using the Duplicate menu item found on the context menu.  To do 
this, select the report item and then right-click to bring up the context menu.  From this menu, 
select Duplicate.  A copy of the selected item will now be inserted below the item.  The new 
copy is now completely independent of the original.

You can permanently delete a report item by selecting the item you want to delete and then 
selecting the Delete menu item from the context menu.  Before the item is deleted you are ask to 
confirm the operation.  Once it is deleted, you cannot bring it back.  You can also do this by 
pressing the Delete key on your keyboard.

You can also rename a report item.  To do this, right-click on the item and select the Rename 
menu item.  Then just type in the new name and press enter or click on something else.  Other 
ways to rename a report item include pressing F2 while the item is selected or click on a report 
item a second time.  The new name is saved with the survey.  You may want to rename an item if 
you have several copies of the same report type.  Your own name will help you quickly identify 
the report item you are looking for.

4.5 Report Properties
A handful of options exist that you can change to modify the default behavior of the program. 
These options are accessed by clicking on the Properties button or selecting the Report 
Properties menu item on the Report menu.  The following lists each option along with a 
description of what it does.

4.5.1 Confidence Radius

The confidence radius can be thought of as a circle that is drawn around each data point collected 
in the survey.  By setting the size of this circle, you are telling VisiWave that you are confident 
that the area inside the circle is well described by the data point collected.  VisiWave uses this 
circle when drawing maps.  It only displays coverage where these circles exist.  For example, if 

VisiWave Site Survey User's Guide 63



you collect a single data point on your survey map, VisiWave will only show the heatmap as a 
single circle around the data point with a radius the length of this confidence radius.

The diagram below represents the confidence radius around each data point collected.  For 
illustration purposes, a red circle is drawn around each data point.  The area within each circle 
includes the heatmap coloring.  But VisiWave can't be certain about the area outside the circles 
because it is further than “r” (the confidence radius) away from any data point.  Therefore, this 
area is left transparent.

Figure 19 - Illustration of Confidence Radius

You can choose any value between 1 and 99 for the confidence radius (this value is in the current 
default units, either feet or meters).  It is up to you to decide what value to use.  If you think that 
a data point collected in one spot is pretty much equivalent to any other location within about 15 
ft (5m) of that spot, then use 15 ft as your confidence radius.  But, if you are doing a city-wide 
survey and collecting data by driving down roads, you may want to use a value more like 50ft 
(15m) since you can't easily collect data anywhere but on the road.

Note that it is important to reveal this value to anyone viewing the site survey report since 
changing this value can greatly affect (or even distort) the results of most survey maps.  This 
value is currently displayed in the Survey Overview report page.

4.5.2 Page Header

Each page of a PDF report can contain a line of text in the top margin.  This field specifies what 
is included in the header.  The header is not included on the first page if the first page is a title 
page.  The following special symbols can be included in the header or footer fields.  The symbols 
are replaced with their current value.
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Symbol Replacement Value
@TITLE The survey title or the value 

“VisiWave Site Survey Report” if 
that isn't set.

@PAGE The current page number
@PAGES The total number of pages
@DATE The current date
@TIME The current time

This option has no affect when creating HTML reports.

4.5.3 Page Footer

Each page of a PDF report can contain a line of text at the bottom.  This field specifies what is 
included in the footer.  The footer is not included on the first page if the first page is a title page. 
The replacement symbols listed for the header value can also be used in the footer.

This option has no affect when creating HTML reports.

4.5.4 Top, Bottom, Left, Right Margin

For PDF reports, these values set the width of the white space on the top, bottom, left, and right 
edges of the page.  The margins are specified in either inches or millimeters, depending on the 
current default units.  If inches are specified, fractions of an inch are also allowed.  For example, 
a quarter inch can be specified as “0.25”.

This option has no affect when creating HTML reports.

4.5.5 Include Figure Numbers

To include a figure number beneath the graphs in the report, set this option to Yes.  The word 
“Figure” and the current figure number are included centered beneath each graph in the report. 
Figures are numbered sequentially from the beginning of the report starting with “1”.

4.5.6 Starting Page Number

Usually this is set to “1”, but if you are planning on combining two or more reports together into 
a single report, then you can change this value to be one more than the last page of the previous 
report.
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4.5.7 Level of Detail

The higher this is set, the more detailed the resulting graphs will appear both on-screen and in 
reports.  However, higher settings will also require longer to generate each graph.

4.6 Generating a Report
When a report is created and ready to be published, you can generate the report.  Generating a 
report causes all the report items to be combined into a single, comprehensive document that 
describes the site survey.  If you don’t want to include a particular report item in the report, you 
can uncheck the checkbox for that report item in the report item list.

Selecting the Generate Report menu item on the Report menu generates a report.  Also, you 
can press either the toolbar icon ( ) or the Generate Report button to generate the report.  Any 
of these actions will bring up a window asking you a few questions.  You will need to select the 
type of report you want to generate, whether you want to automatically view the report after it is 
generated, where you want the generated report to be stored, and a few options about how the 
report will appear.

View After Completion

If this box is checked, the newly generated report will be automatically loaded and displayed by 
the program your computer has configured to handle this type of document.  For example, if you 
are generating an HTML report, your default browser will be launched and the report will appear 
in a new tab.

If you choose to view the report after it is generated, make sure the viewing program doesn’t 
already have a previous copy of the output file loaded.  If it does, the viewing program might 
have the output file locked preventing the new version from being written.

Type of Report

You can create three different types of reports: Portable Document Format (PDF), HTML, or 
Self-Contained HTML.  They all produce basically the same report, but each has different 
advantages and disadvantages.

The PDF file has three main advantages.  One advantage is that it is completely self-contained. 
That means that everything needed to display or print a PDF report is contained in the single PDF 
file.  Another advantage is that a PDF file allows better page oriented formatting which produces 
better printed output.  And the last advantage is that a PDF file’s appearance is more predictable. 
It doesn’t matter what computer you are using to view the PDF file or what method you are using 
to produce a hardcopy output of the report, the appearance should always be very similar.
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The disadvantage of the PDF file format is the need for a special viewer.  The special viewer is 
the Adobe Acrobat Reader version 4.0 or later.  Compatible PDF viewers should also work. 
Acrobat Reader is freely downloadable from the Internet.  Visit www.adobe.com for more 
information.

Creating a report in HTML format has a few advantages as well.  One advantage is that the 
person viewing the report only has to have a standard web browser.  Another advantage is that an 
HTML document doesn’t have any page margins that limit the amount of data that can be 
displayed.  And lastly, it is easy to put an HTML document on a website for others to view.

However, an HTML document is not self-contained.  In order to share the report, you need to 
make the HTML file available as well as all the images included by the HTML file.  When an 
HTML report is generated, the main HTML file is created as well as files containing all the graph 
images linked within the main HTML file.  These graph images are stored in the same folder as 
the main HTML file and have the same base name as the main HTML file.  A numeric suffix is 
added to the end of the base name to make it a unique name and the extension “.png” is used.  

Also, printing a hardcopy version of the report when it is stored in HTML format won’t always 
produce very good results.  HTML is not page oriented, so page breaks can’t be predicted and 
page margins can easily be exceeded.  Also, the web browser will probably use it’s own headers 
and footers when it prints the document.

Self-Contained HTML documents are exactly the same as regular HTML documents except that 
all the images are embedded within the HTML file itself.  This means you can easily share Self-
Contained HTML reports by just making the one HTML file available to others.  However, this 
type of HTML file is not supported by Internet Explorer 8 or earlier.  IE 9 does have support for 
this type of HTML file.  And most other mainstream browsers support this including Firefox, 
Chrome, Opera, and Safari.

Another point that needs to be considered is that Self-Contained HTML files will be about 25%-
33% larger than the equivalent normal HTML document along with all the external image files. 
This increase in size can almost be negated if you compress the Self-Contained HTML file 
before sharing it with others.

Image Resolution

You can select the size of the generated report graphs using this option.  Selecting a resolution of 
Low will generate reports that are smaller in size and therefore easier to share with others.  And 
smaller graphs will fit on almost every sized computer monitor used today.  But generating 
higher resolution report graphs will make reports that are more clear both on-screen and when 
printed.  Note that graph images in PDF documents won't be any bigger on the page when a 
higher resolution is selected, but the images will contain more detail when they are viewed on 
higher resolution devices such as printers or when you zoom in on an image using a PDF viewer.
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Number of Colors

You can select between full color (16 Million colors) and 256 colors.  If you need to make the 
resulting report file smaller, select 256 colors.  The report size will be anywhere from 50% to 
75% smaller than using 16 million colors.  However, if you want the best quality output 
regardless of the size of the reports, use 16 Million colors.

Page Orientation

You can select between portrait or landscape page orientation.  Portrait pages mean they are taller 
than they are wide.  And landscape pages are wider than they are tall.  Typically your choice is 
driven by the size of your survey map.  If your survey map is wider than it is tall, you might want 
to consider using a landscape orientation.  This will make best use of the space on a page.

This option is only available for PDF reports.  Page orientation makes no sense with HTML 
documents since there isn't the concept of pages to begin with.

Paper Size

You can select between many different common US and international standard paper sizes.  A4 
and US Letter are the most common, but a few larger sizes are also available.

Again since HTML reports don't have the concept of pages, this option is only available for PDF 
reports.

4.7 Report Templates
Once you have created a site survey report, you may want to re-use the report on many of the 
surveys you've done.  Instead of re-creating each report item each time, you can use the concept 
of report templates to easily re-use your previous effort on every site survey you do in the future.

To re-use the report you've already created, first you create a template based on your existing 
report.  To do this, you load the survey file that contains the report you have already created and 
save this as a special survey file that is called a template.  Then you can load this template into 
any other survey file and all the report items are automatically added to the new survey file.

4.7.1 Creating a Report Template

Creating a report template is very easy.  Just load the survey file that already has report items in it 
or add report items to the currently loaded survey.  Then press the Template button.  The second 
half of the window that appears applies to creating report templates.  You have two choices 
before you create the template.  First, if you want to include the properties you've set for the 
Quick Views items, put a check mark in the “Include 'Quick Views' report items” box.  Next, if 
you want to include all report items—even those without a check mark next to them—then put a 
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check mark in the “Include unchecked report items” box.  Without selecting this, only report 
items that have a check mark next to them are saved in the template file.

Lastly, select the Save As button.  This will prompt you for a file name for the new report 
template.  This template file is just a regular survey file except it doesn't contain any survey data 
points or a survey map.  You can load it in VisiWave and edit its contents at any time.

4.7.2 Loading a Report Template

You can load any existing survey file and use it as a report template—even if it wasn't created 
specifically as a report template.  In either case, just the report items are examined.

To load a report template into your current survey file, go to the report view and click on the 
Templates button.  At the top of the window that appears, click on the Load button.  Then select 
an existing survey file.  If the survey file has Quick Views report items, you are asked if you want 
to overwrite the current Quick Views properties with the ones from the template file.  Then any 
report items that exist in the survey file are added to the end of the Report Items list.

These new report items can then be used just like any report items you manually added.  You 
could even add other report template files, if desired.

Note that some report properties from report templates won't necessarily apply to the new survey 
data.  For example, the APs in the AP Filter list might be different.  In this case, the same 
numbered APs are selected in the current survey if they exist.  But you should review these to 
make sure they are still applicable.  Another example is if the report template contains any report 
items where a subset of the entire survey map was selected.  Again, VisiWave tries to use the 
zoomed-in area on the new survey map, but this might not exist on the new survey map.
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Appendix A: Migrating Old Report Files
If you previously used a version of VisiWave that created separate VisiWave Report files—these 
had an extension of “.VWR”—then you may wish to migrate those reports to the new types of 
reports that are currently created with VisiWave.  Not all previously available report types and 
properties are available with the new version.  But this migration process tries to map as many 
details as possible from the old format to the new.

To begin with, you should load the survey file (.VWS) that was generated with the previous 
version—VisiWave should be able to directly load a survey file generated by any version of 
VisiWave.  Next switch to the report view by selecting the Report View menu item from the 
View menu.  Next select the Migrate Old Report Files menu item from the Report menu.  A 
notice saying that not everything will migrate is displayed.  Select OK.  Next select the VisiWave 
Report file that you want to migrate (typically the report file you used with the survey file you 
currently have loaded).  After pressing OK here, VisiWave loads the old report file and adds 
every report item from that file that is currently supported.  These new items are added to the end 
of the current list of report items (any currently available report items will remain).  A count of 
the number of items added will then be displayed.

You can now review all of the items just added to make sure they still make sense in your report. 
These new items are now just regular report items and can be changed or deleted just like any 
other report items.
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